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Знакомство с PowerLab 8
n Прост в использовании: подключите PowerLab 8 между источником питания и 

батареей, выберите настройки для батареи и начните заряд, разряд, циклирование 
или мониторинг. Нет переключателей, разъемов или колесиков для настройки! 
Во время автоматического заряда (Auto Charge), PowerLab 8 автоматически определяет 
емкость батареи и устанавливает оптимальный ток, затем при необходимости 
динамически регулирует ток заряда. Кроме того, можно вручную выбрать ток 
заряда в диапазоне от 10mA до 40A.

n Поддерживает балансирующий (в зависимости от батареи) и небалансирующий 
заряд (с определенными ограничениями безопасности) для следующих батарей:

l LiPo (от 1s до 8s балансирующий, от 1s до 2s небалансирующий (максимальный 
ток заряда 2.0A для небалансирующего заряда).

l Li-Ion (от 1s до 8s балансирующий, от 1s до 2s небалансирующий (максимальный 
ток заряда 2.0A для небалансирующего заряда).

l A123©/LiFePO4 (от 1s до 8s балансирующий, от 1s до 10s небалансирующий 
(максимальный ток заряда 20A для небалансирующего заряда).

l LiMn (от 1s до 8s балансирующий, от 1s до 2s небалансирующий (максимальный 
ток заряда 2.0A для небалансирующего заряда).

l NiCd (от 1s до 21s; максимальный ток заряда 20A).

l NiMH (от 1s до 21s; максимальный ток заряда 20A).

l 6V, 12V, 24V свинцово-кислотные (Flooded, Gel, AGM, SLA).

n Хранит до 25 пользовательских настроек (User Presets), оптимизированных для 
различных батарей, обеспечивая стратегии зарядки для наиболее распространенных
RC задач зарядки. Также хранит до 50 библиотечных настроек (Library Presets). 
При использовании управляющей программы (Charge Control Software), количество 
пользовательских настроек практически неограниченно и будет увеличиваться для 
соответствия индустриальным потребностям. Заменяйте и изменяйте настройки 
для соответствия вашим батареям.

n Во время балансирующего заряда, каждая банка балансируется независимо, 
обеспечивая исключительную безопасность и поднимая RC батареи до уровня 
безопасности сотовых телефонов. Типичная батарея емкостью до 4Ah заряжается 
за 40 минут или меньше, при использовании автоматического режима 3C Auto 
Current Mode.

n Последняя технология обеспечивает предельную безопасность - даже заряд 
батарей со скрытыми повреждениями без опасности воспламенения. Батарея не 
будет заряжаться, если напряжение отдельных банок не соответствует общему 
напряжению батареи.

n Балансировка банок с точностью до 78μV с допустимым отклонением до 6mV и 
автоматической защитой от избыточного заряда гарантирует долгий срок службы 
батарей. Автоматический контроль температуры предотвращает избыточный заряд 
при низких окружающих температурах и повреждение зарядного устройства при 
высоких окружающих температурах. Настройки на холодную погоду регулируются 
в пользовательских настройках.

n Выбираемые режимы: только заряд, только разряд, циклирование (заряд/разряд 
любое количество раз) и мониторинг (только измерение напряжения батареи).
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n Выбираемый разряд:
l Внутренний разряд от 10mA до 10A, максимум 100 Вт.
l Регенеративный разряд от 10mA до 40A, максимум 1344 Вт, когда PowerLab 8

питается от свинцовой батареи. Регенеративный разряд использует большую 
часть этой энергии и возвращает ее в батарею питания. Например, когда вы 
разряжаете батарею LiPo для хранения, вы будете перезаряжать вашу свинцовую 
батарею питания.

n Многофункциональный дисплей с подсветкой позволяет вам выбирать 
настройки, заменять настройки по умолчанию из библиотеки и показывает данные 
заряда, такие как напряжение отдельных банок, ток заряда, напряжение питания 
и емкость заряда батареи (mAh). Плюс, уникальный индикатор Fuel показывает 
процент емкости оставшейся в батарее.

n PowerLab 8 Charge Control Software (CCS, бесплатная программа) позволяет вам 
настраивать, сохранять и загружать настройки (включая экраны данных) и 
просматривать в реальном времени данные заряда и графики. CCS также 
управляет обновлением прошивки PowerLab 8.

n Параллельный заряд использует высокую выходную мощность PowerLab 8. После 
подключения батарей с помощью адаптера Safe Parallel Adapter, просто сообщите 
PowerLab 8 сколько батарей подключено - ток заряда/разряда автоматически 
разделится между батареями.

n Smart Power Management, после настройки, предотвращает повреждение вашего 
источника питания или батареи.

n Работает от любого источника постоянного напряжения 12–24 вольт.
Входы и выходы защищены от обратной полярности.

n Режим расширения каналов (Expansion Channel Mode), который позволяет 
взаимодействовать нескольким PowerLab 8, для эффективного заряда нескольких 
батарей одного типа. Главный PowerLab 8 контролирует все аспекты заряда и 
балансировки для всех устройств.



Использование PowerLab 8

Краткая справка

ВАЖНО: Для предотвращения повреждения источника питания, вы 
должны указать для источник питания отсечки по напряжению и 
току, перед тем как заряжать от источника питания, и перед зарядом 
от батареи. После этого, обновляйте характеристики источника питания 
каждый раз, когда вы изменяете источник питания или батарею.
Вы также можете указать отсечки на закладке CCS “Supply”.

Эта краткая справка перечисляет общие задачи PowerLab 8. Что вы хотите сделать?

Для того... Сделайте...
Выбор типа 
источника 
питания*

1. Включите питание.
2. Нажмите любую кнопку.
3. На экране Power Source?, используйте кнопки INC или DEC для выбора Battery или 

DC Power Supply (т.е., что в данный момент питает PowerLab 8).
4. Нажмите ENTER для отображения списка пользовательских настроек (User Preset).

Навигация 
по меню

n В списке пользовательских настроек: Нажимайте INC или DEC для прокрутки через 
пользовательские настройки. Нажмите и держите INC или DEC для быстрой прокрутки.

n В списке пользовательских настроек: Нажмите ENTER для настройки заряда.

n В меню: Нажимайте INC или DEC для прокрутки. Нажмите и держите INC или DEC для 
быстрой прокрутки.

n В меню: Нажмите ENTER для выбора отображаемой опции и перехода на следующий экран.
n Нажмите BACK для возврата на предыдущий экран.
n Нажмите и держите BACK для перехода к пользовательским настройкам из любого места.
n Нажмите INC+DEC (одновременно) для доступа к функциям Preset Settings, Charger

Options, Manage Presets и Button Help.
Подключение 
батареи

n Для балансирующего заряда до 3A: Подключите 9-контактный разъем к разъему 
балансировки (может потребоваться адаптер).

n Для балансирующего заряда с любым током: Подключите силовые провода 
батареи к выходным разъемам зарядника, подключите 9-контактный разъем к 
разъему балансировки (может потребоваться адаптер).

n Для небалансирующего заряда: Подключите силовые провода батареи к 
выходным разъемам зарядника.

Подробности
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Заряд,
разряд,
циклирование
или 
мониторинг 
батареи

1. Включите питание и выберите источник питания (смотрите выше).
2. Подключите батарею.
3. Нажмите INC или DEC для выбора o желаемой настройки, затем нажмите ENTER.
4. Для каждого вопроса, нажимайте INC или DEC для выбора правильного ответа,

затем нажмите ENTER.
5. CHECKING PACK индицирует, что PowerLab 8 пытается определить батарею.
6. Экран отобразит химию настройки. Если она соответствует батарее, нажмите 

ENTER для старта (Если не соответствует, подождите следующего сообщения, 
потом нажмите ENTER для возврата к списку пользовательских настроек).

7. Во время работы:
n Нажмите INC или DEC для просмотра данных.
n Нажмите ENTER для изменения тока заряда.
n Нажмите и держите ENTER для остановки работы.

8. “Бип бип бип” индицирует завершение операции. Экран отобразит прошедшее 
время. Нажмите INC/DEC для просмотра данных.
Работа завершена, но “сессия” остается открытой, и вы можете просмотреть 
собранные данные.
Нажмите и держите ENTER для завершения сессии (это стирает данные сессии).

9. Отсоедините батарею.
10. Нажмите ENTER для возврата к списку пользовательских настроек.

Подробности

Заряд 
батарей 
параллельно

Используйте только адаптеры REVOLECTRIX Safe Parallel Adapters и составные силовые 
разъемы, когда заряжаете/разряжаете/циклируете батареи параллельно.Подключите до 9 
батарей - одинаковой химии, с одинаковым числом банок и емкостью - параллельно, 
соединив силовые разъемы. Заряжайте, как описано выше, но введите число батарей 
в вопросе Parallel Packs? (например, 2P, 3P, 4P). PowerLab 8 разделяет ток поровну 
между батареями.

Подробности

*Предполагает, что Choose Power Source at Startup включен в CCS.
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Настройка Smart Power Management
ВАЖНО: Для предотвращения повреждения источника питания, вы 
должны указать для источник питания отсечки по напряжению и 
току, перед тем как заряжать от источника питания, и перед зарядом 
от батареи. После этого, обновляйте характеристики источника питания 
каждый раз, когда вы изменяете источник питания или батарею.

Вы можете настроить множество рабочих опций, включая очень важные пороги по 
напряжению и току источника питания.Вы можете настроить Smart Power Management
как в PowerLab 8 (описано ниже) или на закладке Источник питания (Supply).

Так как PowerLab 8 способен обеспечить высокую мощность, весьма рекомендуется, 
чтобы вы настроили Smart Power Management перед тем, как использовать 
PowerLab 8 for в первый раз, и настроить его снова, когда вы значительно 
изменяете источник питания - источник питания или свинцовый аккумулятор.

PowerLab 8 хранит два профиля Smart Power Management: один для источника 
питания и один для свинцового аккумулятора. Когда вы подаете питание на PowerLab
8, первое, что вы должны сделать, это выбрать профиль, который соответствует 
используемому источнику питания. Это облегчает изменение профиля Smart Power
Management от источника питания дома к свинцовому аккумулятору в поле.

Если вы не настраивали Smart Power Management для соответствия вашим 
источникам питания, это будут настройки по умолчанию:

n Источник питания (DC supply):

l Нижний предел по напряжению: 10V
l Верхний предел по току: 25A

n Свинцовая батарея:
l Нижний предел по напряжению: 11V
l Верхний предел по току: 25A

n Регенеративный разряд, когда включен (по умолчанию выключен):
l Верхний предел по напряжению в свинцовый аккумулятор: 14.40V
l Верхний предел по току в свинцовый аккумулятор: 10A

Примечание: Все эти параметры могут настраиваться напрямую в 
PowerLab 8, исключая пороги регенеративного тока и напряжения,
которые должны настраиваться через CCS.

Следующая процедура настраивает Smart Power Management для источника 
питания и свинцовой батареи.

1. Подключите PowerLab 8 к источнику питания 10–32В или к свинцовой батарее.

2. Нажмите любую кнопку на панели PowerLab 8.

3. На экране Power Source?, используйте кнопку INC или DEC для выбора
Battery или DC Power Supply (т.е., что сейчас питает PowerLab 8).

4. Нажмите ENTER для отображения списка пользовательских настроек.
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5. Нажмите INC+DEC (т.е. одновременно нажмите INC и DEC) для отображения 
меню Options (Choose TASK?).

6. Нажимайте INC или DEC пока не увидите Charger Options, затем ENTER.

7. Экран Charger Address? должен отобразить PRIMARY CHANNEL (если вы не 
используете несколько PowerLab). Если не отобразилось, нажимайте INC или 
DEC пока не увидите PRIMARY CHANNEL. Нажмите ENTER.

8. На экране Power Source?, нажмите INC или DEC для выбора DC Power Supply,
затем нажмите ENTER.

9. На экране Supply Current Limit?, нажмите INC или DEC для указания порога 
по току, подходящего для вашего источника питания, затем нажмите ENTER
(Порог по току должен быть немного меньше, чем максимальный ток источника 
питания. Для защиты источника питания от повреждений, PowerLab 8 никогда не 
потребляет больший ток, чем вы указали здесь, но ток заряда может не достигать 
установленного или или вручную настроенного значения).

10. На экране Low Sply Limit?, нажмите INC или DEC для указания порога по 
напряжению, затем нажмите ENTER. (Порог напряжения должен быть примерно 
на 50% меньше, чем номинальное напряжение источника питания. Пример: Для 
источника питания 24В, укажите пороговое напряжение 12V.Для защиты источника 
питания, зарядка останавливается, если напряжение источника питания падает 
ниже установленного здесь значения).

11. На экране Use Regenerative Discharge?, нажмите и держите кнопку BACK, так 
как эта возможность неприменима к источнику питания. Вы возвратитесь к 
списку пользовательских настроек.

Вы успешно настроили Smart Power Management для источника питания. Далее,
повторите процесс для вашего свинцового аккумулятора.

12. Нажмите INC+DEC (т.е. одновременно нажмите INC и DEC) для отображения 
меню Options (Choose TASK?).

13. Нажимайте INC или DEC пока не увидите Charger Options, затем ENTER.

14. На экране Power Source?, нажмите INC или DEC для выбора Battery, затем 
нажмите ENTER.

15. На экране Battery Current Limit?, нажмите INC или DEC для указания порога 
по току для вашей свинцовой батареи, затем нажмите ENTER (Максимальный 
ток свинцовой батареи может изменяться в широких пределах. Обычно,
стандартный автомобильный свинцовый аккумулятор может длительно 
обеспечивать ток 25A и 50A в течение короткого времени. Аккумулятор AGM
может длительно обеспечивать ток 50A без существенного сокращения срока 
службы. Для защиты вашего аккумулятора от повреждения, PowerLab 8 никогда 
не будет потреблять больший ток, чем вы указали здесь, но ток заряда может не 
достигать установленного или или вручную настроенного значения).

16. На экране Bat. Low Cutoff?, нажмите INC или DEC для указания порога по 
напряжению, затем нажмите ENTER (Порог по напряжению не должен быть 
ниже 11В для свинцового аккумулятора 12В. Более низкий порог обеспечит 
более долгую работу PowerLab 8 ценой срока службы свинцового аккумулятора.
Если вы используете два последовательных аккумулятора 12В для получения 
напряжения 24В, PowerLab 8 автоматически удвоит порог по напряжению,
который вы установили. Для защиты аккумулятора, зарядка останавливается,
если напряжение аккумулятора падает ниже установленного здесь значения).
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17. На экране Use Regenerative Discharge?, нажмите INC или DEC для включения 
или выключения этой возможности, затем нажмите ENTER (Регенеративный 
разряд возвращает энергию обратно в аккумулятор питания во время цикла 
разряда батареи).

18. Нажмите и удерживайте кнопку BACK для возврата к списку пользовательских 
настроек.

Теперь настройка Smart Power Management завершена. В следующий раз при 
включении PowerLab 8, он запросит выбрать DC Power Supply или Battery в качестве 
источника питания, но теперь он будет использовать настройки, которые вы ввели 
для управления питанием от выбранного источника.

Смотрите также закладку Источник питания (Supply) CCS
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Настройки
Примечание:Настройка сохраняется как только вы измените ее. Также, 
вам не нужно проходить через всю последовательность - в любой 
момент, вы можете нажать и держать кнопку BACK для возврата к 
списку пользовательских настроек.

1. Подключите PowerLab 8 к источнику питания 10-32В или к свинцовому аккумулятору.

2. Нажмите любую кнопку на панели PowerLab 8.

3. На экране Power Source?, используйте кнопку INC или DEC для выбора Battery
или DC Power Supply (т.е., что сейчас питает PowerLab 8).

4. Нажмите ENTER для отображения списка пользовательских настроек.

5. Нажмите INC+DEC (т.е. одновременно нажмите INC и DEC) для отображения 
меню Options (Choose TASK?).

6. Нажимайте INC или DEC пока не увидите Charger Options, затем нажмите ENTER.

7. Экран Charger Address? должен отобразить PRIMARY CHANNEL (если вы не 
используете несколько PowerLab). Если не отобразилось, нажимайте INC или DEC
пока не увидите PRIMARY CHANNEL. Нажмите ENTER.

8. На экране Power Source?, нажимайте ENTER пока не увидите экран Decimal
Places for Cells? (смотрите Настройка Smart Power Management для инструкций по 
настройке этой опции).

9. На экране Decimal Places for Cells?, нажмите INC или DEC для выбора 2 или 3,
затем нажмите ENTER. (это определяет, сколько десятичных разрядов отображается 
на экранах данных напряжения банок).

10. На экранеQuiet Charging?, нажмите INC илиDEC для выбораY илиN, затем нажмите 
ENTER. (Y = нет сигналов во время зарядки, N = сигналы во время зарядки).

11. На экране Speaker Volume?, нажмите INC или DEC для настройки громкости 
сигналов, затем нажмите ENTER. (1 = самый тихий. Во время настройки, динамик 
сигналит с громкостью указанной на экране).

12. На экране Sound Button Clicks?, нажмите INC или DEC для выбора Y или N, затем 
нажмите ENTER. (Озвучивание нажатия кнопок обеспечивает звуковую обратную 
связь, когда вы нажимаете кнопки PowerLab 8).

13. На экране Charge Complete Beeps?, нажмите INC или DEC для выбора номера,
затем нажмите ENTER. (это определяет сколько раз PowerLab 8 повторяет “бип
бип бип”, когда завершается зарядка).

14. На экране Preset Changes Always Save?, нажмите INC или DEC для выбора Y или 
N, затем нажмите ENTER. (Y = изменения сделанные в пользовательской 
настройке PowerLab 8 всегда сохраняются в запущенной настройке и загружаются в 
программу CCS.Установка в N не рекомендуется, но предоставляет способ временного 
изменения настроенных параметров - как только вы переходите к другой настройке,
все изменения теряются и пользовательская настройка возвращается в предыдущее 
состояние).

15. На экране Choose TASK?:
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n Нажмите INC или DEC для выбора другой функции для настройки.

n Нажмите BACK для отображения списка пользовательских настроек.

Смотрите также
Закладка Настройки (Options) CCS
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Подключение батарей: основы

Подключите батарею к выходным разъемам PowerLab 8, разъему балансировки 
или к обоим разъемам.

Разъем балансировки принимает 9-контактный штекер балансировки Cellpro,
который поддерживает батареи до 8S. Для токов заряда/разряда до 3A, вы можете 
подключить только разъем балансировки, как показано ниже. Если у батареи другой 
тип разъема балансировки, REVOLECTRIX предоставляет несколько адаптеров 
для большинства наиболее популярных типов и марок разъемов (посетите раздел 
Cellpro Adapters веб-сайте REVOLECTRIX).

Если у батареи есть силовые провода и разъем балансировки, подключите оба к 
PowerLab 8 (подходит для любого тока зарядки/разрядки):

Примечание: Наилучшим способом будет сначала подключать 
разъем балансировки, а затем силовые провода.
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Для заряда без балансировки, подключите батарею к PowerLab 8 следующим образом:

Если штатные адаптеры REVOLECTRIX не работают для ваших батарей, вы можете 
изготовить собственные адаптеры, используя шлейф CPBP9P-10 Cellpro, который 
состоит из 9-контактного разъема с проводами. Смотрите Разводка балансировочного 
разъема в этом руководстве, и “CellPro Node Connector Manual” доступный на 
странице Downloads на веб-сайте REVOLECTRIX.
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Подключение батарей: расширенно

Таблица ниже перечисляет несколько общих конфигураций зарядки PowerLab 8.
Найдите конфигурацию, которая наиболее близко соответствует тому, как вы хотите 
заряжать, затем нажмите на ссылку “Подробно” для дополнительной информации.

Количество 
батарей

Количество 
PL8s

Режим Количество 
источников 

питания

Силовые 
провода

A 1 1 Normal Да Нет 1 Подробно

B 1 1 Normal Да Да 1 Подробно

C 2 и более* 1 Normal Да Да 1 Подробно

D 1 (10s и более с 
центр. выводом)

1 Normal Да Да 1 Подробно

E 2 2 Normal Да Да 1 Подробно

F 2 2 Normal или 
Expansion
Channel

Да Да 1 Подробно

G 1 (10s и более с 
центр. выводом)

2 Normal или 
Expansion
Channel

Да Да 1 Подробно

H 1 (10s и более с 
центр. выводом)

2 Normal Да Да 2,
изолированные

Подробно

* Свыше 9 батарей параллельно, вы отвечаете сами за определение тока зарядки/разрядки для каждой батареи.
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Конфигурация A
Сводка: базовая зарядка одной батареи через разъем балансировки.

Компоненты: 

n 1 PowerLab 8
n 1 источник питания

n 1 стандартный адаптер (адаптер “Safe Parallel” не поддерживает зарядку 
только через балансировочный разъем)

n 1 батарея

n Опциональный адаптер FUIM3 для поддержки компьютера

Режим PowerLab 8 (Normal или Expansion Channel): Normal.

Максимальная мощность заряда PowerLab 8: до 100 Вт заряд 1 батареи (8s);
зарядка только через балансировочный разъем ограничена током максимум 3A.
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Конфигурация B
Сводка: базовая зарядка одной батареи через силовые и балансировочные провода.

Компоненты:

n 1 PowerLab 8
n 1 источник питания

n 1 стандартный или “Safe Parallel” адаптер

n 1 батарея

n Опциональный адаптер FUIM3 для поддержки компьютера

Режим PowerLab 8 (Normal или Expansion Channel): Normal.

Максимальная мощность заряда PowerLab 8: до 1344 Вт заряд одной батареи (8s) с 
использование источника питания 24 В / 1700 Вт.
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Конфигурация C
Сводка: параллельный заряд.

Компоненты:

n 1 PowerLab 8
n 1 источник питания

n 1 адаптер “Safe Parallel” для каждой батареи (не используйте стандартные 
адаптеры)

n 2 или более батарей (свыше 9 батарей, вы отвечаете сами за определение 
тока зарядки/разрядки для каждой батареи)

n Опциональный адаптер FUIM3 для поддержки компьютера

Режим PowerLab 8 (Normal или Expansion Channel): Normal.

Максимальная мощность заряда PowerLab 8: до 672 Вт заряда каждой из 
двух батарей заряжаемых параллельно с использованием источника 
питания 24 В / 1700 Вт.

Ограничения: 

n 1 батарея на адаптер.
n Проверка полярности батарей.
n Одинаковое количество банок для всех батарей.
n Использование силовых проводов батареи.
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Смотрите также
Зарядка батарей параллельно
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Конфигурация D
Сводка: параллельный заряд расщепленных батарей (10s или больше).

Компоненты: 

n 1 PowerLab 8
n 1 источник питания

n 2 адаптера “Safe Parallel”
n 1 10s (или больше) расщепленная батарея с центральным выводом

n Опциональный адаптер FUIM3 для поддержки компьютера

Режим PowerLab 8 (Normal или Expansion Channel): Normal.

Максимальная мощность заряда PowerLab 8: до 672 Вт заряда каждой из 
двух батарей заряжаемых параллельно с использованием источника 
питания 24 В / 1700 Вт.

Ограничения: 

n 1 сторона батареи на адаптер.
n Проверка полярности батарей.
n Одинаковое количество банок на обоих сторонах.
n Использование силовых проводов батареи.

– 20 –

Руководство пользователяPowerLab 8



– 21 –

Руководство пользователяPowerLab 8



Конфигурация E
Сводка: два PowerLab 8 заряжают две отдельных батареи, один источник питания.

Компоненты:

n 2 PowerLab 8
n 1 источник питания

n 2 стандартных или “Safe Parallel” адаптера (1 адаптер на батарею)
n 2 батареи (адаптеры “Safe Parallel” требуют одинакового количества банок

для обоих батарей)
n 2 опциональных адаптера FUIM3s для поддержки компьютера с двумя

экземплярами CCS

Режим PowerLab 8 (Normal или Expansion Channel): Normal.

Максимальная мощность заряда PowerLab 8: до 1344 Вт для каждой батареи (8s) с
использованием блока питания 24 В / 3400 Вт. Стандартное домашнее питание
может не обеспечить достаточной мощности; может потребоваться источник
питания 240 В для полной мощности.
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Конфигурация F
Сводка: два PowerLabs 8 заряжают отдельные батареи, один источник питания,

режим Expansion Channel.

Компоненты:

n 2 PowerLab 8
n 1 источник питания

n 2 стандартных или “Safe Parallel” адаптера (1 адаптер на батарею)
n 2 батареи (адаптеры “Safe Parallel” требуют одинакового количества банок 

для обоих батарей)
n 1 опциональный адаптер FUIM3 для поддержки компьютера

n 1 опциональный “Y”-коннектор (требуется для работы Expansion Channel с 
поддержкой компьютера)

n Кабель для сервоприводов папа-папа (требуется для работы Expansion
Channel с поддержкой компьютера)

Режим PowerLab 8: Expansion Channel.

Максимальная мощность заряда PowerLab 8: до 1344Вт для каждой батареи (8s) с 
использованием блока питания 24 В / 3400 Вт. Стандартное домашнее питание 
может не обеспечить достаточной мощности; может потребоваться источник 
питания 240 В для полной мощности.
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Смотрите также
Режим расширения каналов
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Конфигурация G
Сводка: два PowerLab 8 заряжают расщепленную батарею (10s или больше),

один источник питания, режим Expansion Channel.
Компоненты: 

n 2 PowerLab 8
n 1 источник питания

n 2 стандартных или “Safe Parallel” адаптера (1 адаптер на сторону батареи)
n 1 расщепленная батарея 10s (или больше) с центральным выводом

n 1 опциональный адаптер FUIM3 для поддержки компьютера

n 1 опциональный “Y”-коннектор (требуется для работы Expansion
Channel с поддержкой компьютера)

n Кабель для сервоприводов папа-папа (требуется для работы 
Expansion Channel с поддержкой компьютера)

Режим PowerLab 8: Expansion Channel.

Максимальная мощность заряда PowerLab 8: до 1344 Вт для каждой батареи (8s)
с использованием блока питания 24 В / 3400 Вт. Стандартное домашнее питание 
может не обеспечить достаточной мощности; может потребоваться источник 
питания 240 В для полной мощности.

Если не используется режим Expansion Channel, удалите кабель для сервоприводов 
папа-папа и “Y”-коннектор, и используйте 2 адаптера FUIM3s и 2 экземпляра CCS
для управления двумя PowerLab 8.
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Смотрите также
Режим расширения каналов
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Конфигурация H
Сводка: два PowerLab 8 заряжают батарею (10s или больше) с центральным 
выводом, два источника питания, режим Normal.

Компоненты:

n 2 PowerLab 8
n 2 ЭЛЕКТРИЧЕСКИ ИЗОЛИРОВАННЫХ источника питания:

свинцовые батареи или источники питания (см. примечание ниже)
n 2 стандартных или “Safe Parallel” адаптера (1 адаптер на сторону батареи)
n 1 батарея 10s (или больше) с центральным выводом
n Перемычка предоставляемая пользователем (смотрите схему)
n 2 опциональных адаптера FUIM3s для поддержки 

компьютера с двумя экземплярами CCS

Режим PowerLab 8 (Normal или Expansion Channel): только Normal.

Максимальная мощность заряда PowerLab 8: до 1344 Вт для каждой батареи
(8s) с использованием двух источников питания 24 В / 1700 Вт. Стандартное
домашнее питание может не обеспечить достаточной мощности для двух
источников питания; каждый источник питания должен включаться отдельно.

ВАЖНО:Источники питания часто имеют общую землю через сетевые 
розетки, и следовательно не изолированы. С источниками питания 
включенными в розетки и ВЫКЛЮЧЕННЫМИ, используйте тестер 
проводки или омметр для проверки отсутствия проводимости между 
выходными разъемами источников питания, перед тем как подключать 
PowerLab 8. Отсутствие электрической изоляции источников питания 
повредит PowerLab, а также батарею.
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Источники питания

PowerLab 8 является одним из наиболее мощных устройств обслуживания RC батарей 
доступных на данный момент. Работая на полной мощности, он может обеспечить 
мощность 1344 Вт во время зарядки батареи. Для достижения этого, даже с 
батареей LiPo 8 банок, он должен поднимать входное напряжение. Это означает, 
что PowerLab 8 может потреблять от источника питания до 1600 Вт.

Для полного использования мощности PowerLab 8, источник питания должен 
обеспечивать напряжение 26,35 В (более высокое напряжение не увеличивает выходную 
мощность), и способен обеспечивать ток минимум 60A на вход PowerLab 8. По 
закону Ома, 26,35 В x 60A = 1581 Вт. Однако, обычно не рекомендуется нагружать 
источник питания на 100%.Поэтому, если вы хотите достичь выходной мощности 1344
Вт для литиевой батареи 8s, источник питания должен быть способен обеспечивать 
выходную мощность 1700 Вт или больше.
Также, если вам не нужна полная выходная мощность PowerLab 8, он может работать 
от менее мощного источник питания. Используйте шаги описанные Настройка 
Smart Power Management для конфигурирования PowerLab 8 таким образом, чтобы 
он никогда не превышал максимальных возможностей источника питания, как для 
источника питания или для свинцового аккумулятора.
Для дополнительной информации о выборе источника питания, загрузите файл 
PowerLab Power Spreadsheet.

Смотрите также
Закладка Источник питания (Supply) CCS
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Заряд/разряд/циклирование/мониторинг батареи

Совет: Эти подробные инструкции помогут вам понять как проходить 
через процесс зарядки. Для коротких инструкций, смотрите Краткая 
справка. Как только вы ознакомитесь с операциями PowerLab 8, вам 
больше не понадобятся инструкции.

ВАЖНО: Для предотвращения повреждения источника питания, вы 
должны указать для источник питания отсечки по напряжению и 
току, перед тем как заряжать от источника питания, и перед зарядом 
от батареи. После этого, обновляйте характеристики источника питания 
каждый раз, когда вы изменяете источник питания или батарею.

1. Подключите PowerLab 8 к источнику питания 10-32 В или к батарее 12–24 В.

2. Нажмите любую кнопку для отображения экрана Power Source?. Затем:

a. Нажмите INC или DEC для указания используемого источника питания.
b. Нажмите ENTER.

Примечание: Если вы в первый раз используете этот источник питания, в этот 
момент вы должны указать рабочие характеристики источника питания .Если вы ранее 
указывали эти характеристики, PowerLab 8 будет использовать эти настройки.

Примечание: Пропустите этот шаг,если вы отключили опцию Choose Power
Source at Startup на закладке CCSНастройки (Options).

3. Подключите батарею к PowerLab 8:

a. Если батарея имеет разъем балансировки, подключите разъем к PowerLab 8.
(смотрите подробности в Подключение батарей: основы).

Примечание: Если вы будете заряжать батарею LiPo током 10A или больше,
выберите настройку с заголовком High Power.

5. Для выбранной пользовательской настройки (User Preset):

a. Нажмите INC или DEC для выбора корректного ответа на каждый вопрос,
затем нажмите ENTER.
n Parallel Packs? (выберите No если заряжаете одну батарею, от 2P до 9P

для параллельных батарей; NOT ALLOWED для некоторых химий).
n Set Charge Rate? (выберите 1.0C, 2.0C, 3.0C или выберите вручную).
n Set Dsch. Rate? (выберите ток разряда).
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b. Если вы заряжаете батарею через силовые провода батареи (требуется при 
токе заряда >3A или если у батареи нет шлейфа балансировки), подключите 
силовые провода к PowerLab 8.

4. В списке пользовательских настроек (User Preset):

a. Нажмите INC или DEC для нахождения настройки, которую вы хотите 
использовать. Нажмите и держите INC или DEC для быстрой прокрутки.

b. Нажмите ENTER, затем перейдите к шагу 5.
или
Нажмите и держите ENTER, затем перейдите к шагу 6 (если активировано 
Enable Quick Start на закладке CCS Настройки (Options) ; вы пропустите 
большинство вопросов).



b. На вопрос START?, выберите одно из следующего, затем нажмите ENTER:
n CHARGE ONLY (т.е. без разряда).
n DISCHARGE ONLY (т.е без заряда).
n MONITOR (нет заряда или разряда, просто контроль напряжения банок).
n n CYCLE (выполнить n циклов заряда/разряда, как указано в настройке).

Совет: Число циклов указывается в настройке.Смотрите Изменение настройки 
для изменения количества циклов или других аспектов настройки.

6. На вопрос Use Banana Jacks?, нажмите INC или DEC для указания, 
подключены ли силовые провода между батареей и PowerLab 8, затем нажмите 
ENTER.

Примечание: Пропустите этот шаг, если вы включили опцию Suppress Use
Bananas Question на закладке CCS Настройки (Options).

7. PowerLab 8 отобразит CHECKING PACK для проверки подключения батареи.
Если батарея подключена, тогда...

8. PowerLab 8 отобразит химию настройки (например, LiPo) и запросит у вас 
проверить, что это правильно (что это должно быть, например, LiPo). Эта 
проверка дает вам шанс предотвратить зарядку, если настройка и батарея не 
соответствуют.

n Если отображенная химия соответствует химии батареи, нажмите ENTER
для старта зарядки. Перейдите к шагу 9.

или
n Если отображенная химия не соответствует химии батареи, ничего не 

делайте - экран закроется по таймауту. В запросе, нажмите ENTER tдля 
просмотра меню настроек. Перейдите к шагу 4.

9. Во время работы:

n Нажмите INC или DEC для просмотра различных экранов данных 
(отображается ряд экранов и данных, в зависимости от конфигурации 
пользовательской настройки).

Совет: Вы можете также просматривать данные зарядки и графики в 
программе CCS.

n Нажмите ENTER для изменения тока заряда или разряда (только для этой 
сессии).

n Для остановки работы:

a. Нажмите и держите ENTER. Вы увидите CHARGER STOPPED.
b. Нажмите ENTER для возврата к списку пользовательских настроек.

10. Когда операция завершена, PowerLab 8 просигналит несколько раз “бип бип 
бип” и отобразит ELAPSED [time] / [chemistry] DONE. Нажмите INC и 
DEC для просмотра экранов данных.

Примечание: Настройки NiMH, NiCd и свинцовых батарей могут переключаться 
на струйный заряд (trickle charge), после завершения основной зарядки.
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Примечание: Операция завершена, но сессия остается открытой, поэтому вы 
можете просматривать собранные данные. Когда вы нажмете и подержитеENTER,
собранные данные будут сброшены. Если вы отключите батарею до окончания 
сессии, PowerLab 8 отобразит ошибку “Pack Removed”.

11. Нажмите и держите ENTER. Экран отобразит CHARGER STOPPED.

12. Нажмите ENTER или BACK для возврата к пользовательским настройкам.

13. Отключите батарею от PowerLab 8.

PowerLab 8 готов к зарядке другой батареи (шаг 3).

Быстрый старт
Когда вы следуете инструкциям приведенным выше, вы можете заметить, что 
PowerLab 8 задает много вопросов перед началом заряда, разряда, циклирования 
или мониторинга. Это позволяет вам точно указать, как будет работать PowerLab 8
во время этих операций. Как только настройки сконфигурированы правильно, две 
настройки на закладке CCS Настройки (Options) могут ускорить процесс:

n Активация опции Enable Quick Start.
Когда активировано, Enable Quick Start позволяет вам пропустить много 
вопросов необходимых для старта процесса. После активации этой возможности,
нажмите и держите ENTER, если вы не хотите выбирать опции, такие как 
разрядка/циклирование/мониторинг.

n Отключите опцию Choose Power Source at Startup (только если вы постоянно 
используете одинаковый источник питания). При запуске, PowerLab 8 всегда 
будет использовать профиль источника питания или свинцового аккумулятора 
- что было загружено последним перед выключением этой опции.

Примечание: Вы можете также включить опцию Suppress Use
Bananas Question, но это не рекомендуется.
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Заряд/разряд/циклирование батарей параллельно

PowerLab 8 может заряжать, разряжать или циклировать до 9 LiPo или A123 
батарей параллельно. Параллельные операции могут сохранить много времени, 
но вы должны следовать следующим правилам: 

n Всегда используйте адаптеры Safe Parallel Adapters (доступные на веб-
сайте REVOLECTRIX). Никогда не используйте стандартные адаптеры.

n Подключайте только 1 батарею на адаптер Safe Parallel Adapter.
Последовательно соединяйте несколько адаптеров!

n Параллельные операции с использованием адаптеров Safe Parallel Adapter
требуют, чтобы вы подключали к PowerLab 8 вместе балансировочный 
шлейф и силовые провода батареи.

n Всегда соблюдайте правильную полярность!
n Батареи ДОЛЖНЫ иметь одинаковое количество банок.
n Батареи ДОЛЖНЫ иметь одинаковую химию.

Наилучшим способом подключения силовых проводов параллельно, является 
соединение силовых проводов как показано на рисунке:

Процесс заряда такой же, как для одной батареи, за исключением вопроса 
Parallel Packs?, используйте кнопки INC иDEC для указания количества батарей, 
соединенных параллельно. PowerLab 8 делит ток заряда/разряда поровну между 
батареями.

Смотрите также
Подключение батарей: Конфигурация C
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Режим расширения каналов

В нормальном режиме (Normal), несколько PowerLab 8 работают независимо. Подключите 
любое количество PowerLab 8 к портам USB компьютера, и запустите несколько 
экземпляров CCS. Каждый Lab 8 будет общаться с отдельным экземпляром CCS.
В режиме расширения каналов (Expansion Channel), несколько PowerLab 8 соединяются 
через компьютерные порты каждого зарядника. Используйте этот режим, когда вы
хотите заряжать несколько сходных батарей с минимальным нажатием кнопок. Режим 
расширения каналов является модульным подходом к обслуживанию сходных батарей:
батареи должны быть одинаковой химии, но количество банок может быть разным.
При поставке, все PowerLab 8 сконфигурированы для работы как “Primary” или “Master”.В 
менюOPTIONS, вы назначаете один или более PowerLab 8 как “Expansion”, т.е., Expansion
Ch. 1, Expansion Ch. 2 и т.д.. Общаясь через компьютерные порты, зарядник “Primary”
управляет работой всех зарядников “Expansion” - настройка источника питания, настройки 
и пользовательские настройки. Все клавиатуры зарядников “Expansion” выключены, за 
исключением одной функции, которая позволяет снова сделать их “Primary”:
INC+DEC для отображения меню OPTIONS.

Примечание:В режиме расширения каналов, каждыйPowerLab 8 должен 
иметь подключенную батарею, иначе “Primary” генерирует ошибку.

Для работы в режиме расширения каналов (Expansion Channel):

n Батареи ДОЛЖНЫ иметь одинаковую химию, так как одна пользовательская 
настройка контролирует заряд, разряд или циклирование всех PowerLabs.

n Батареи могут иметь различное количество банок.
n Батареи могут иметь различную степень заряда.

1. (Опционально) Соедините корпуса PowerLab 8, используя направляющие 
по сторонам. Имеется два винта для крепления прилегающих корпусов.

2. Соедините два PowerLab 8, используя кабель для сервоприводов папа-папа.
когда соединяется более двух PowerLab 8, или когда вы подключаете к 
компьютеру для поддержки CCS, используйте “Y”-коннектор (смотрите 
Конфигурация F и Конфигурация G, для примера).

3. Назначьте один PowerLab 8 в качестве главного (primary), и назначьте 
каждому остальному уникальный адрес расширения каналов. На каждом 
PowerLab 8:
a. Нажмите INC+DEC для отображения меню Options (Choose TASK?).
b. Нажимайте INC или DEC пока не увидите Charger Options, затем 

нажмите ENTER.
c. На экране Charger Address?, выберите PRIMARY CHANNEL для 

главного зарядника, или выберите EXPANSION CH. n для других 
зарядников (каждый зарядник должен иметь уникальный адрес канала),
затем нажмите ENTER.

d. При необходимости, настройте другие опции.
e. Нажмите и держите BACK для выхода из настроек.

4. Подключите батарею к каждому заряднику.

5. На главном (Primary) заряднике:
a. Выберите пользовательскую настройку подходящую для батарей, затем 

нажмите ENTER.
b. Ответьте на все вопросы и начните заряд.
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c. PowerLab 8 отобразит CHECKING PACK для проверки подключения 
батарей к каждому заряднику. Если батареи подключены, тогда...

d. Подтвердите, что химия настройки соответствует химии батареи, 
нажатием ENTER.

6. Во время заряда:

n Нажмите INC или DEC на главном заряднике для просмотра данных. Данные 
будут отображаться на каждом PowerLab для подключенной батареи.

Совет: Вы можете также просматривать данные и графики в программе 
CCS.На закладкахCells, Int. Res. и Supply, используйте выпадающие 
списки для отображения данных с конкретного зарядника.

n Нажмите ENTER на главном заряднике для изменения тока заряда или 
разряда (для всех зарядников).

n Для остановки заряда на всех зарядниках:

a. На главном заряднике, нажмите и удерживайте ENTER. Вы 
увидите CHARGER STOPPED.

b. Нажмите ENTER для возврата к списку пользовательских настроек.

7. Когда зарядка завершена, каждый зарядник несколько раз просигналит “бип 
бип бип” и экран отобразит ELAPSED [time] / [chemistry] DONE. На 
главном заряднике, нажмите INC и DEC для просмотра данных. Данные 
будут отображаться на каждом PowerLab 8 для подключенной батареи.

Примечание: Настройки NiMH,NiCdи свинцовых батарей могут переключаться 
на струйный заряд (trickle charge), после завершения основной зарядки.

Примечание: Операция завершена, но сессия остается открытой, поэтому 
вы можете просматривать собранные данные. Когда вы нажмете и подержите 
ENTER, собранные данные будут сброшены. Если вы отключите батарею 
до окончания сессии, PowerLab 8 отобразит ошибку “Pack Removed”. Это не 
критическая ошибка и вы можете ее игнорировать.

8. После того, как все зарядники завершили зарядку, на главном 
заряднике нажмите и удерживайте ENTER. Экран отобразит 
CHARGER STOPPED.

9. На главном заряднике, нажмите ENTER или BACK для возврата к 
пользовательским настройкам.

10. Отсоедините батареи от всех зарядников.
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Регенеративный разряд

Регенеративный разряд перенаправляет большую часть энергии из разряжаемой 
батареи в свинцовый аккумулятор, который питает PowerLab 8. Эта возможность 
доступна только, когда PowerLab 8 питается от свинцового аккумулятора.
Регенеративный разряд поддерживает максимум до 40A, 1344 Вт.

Регенеративный разряд

n Включите/выключите регенеративный разряд в PowerLab 8 через Smart Power
Management для батареи питания.

n Включите/выключите регенеративный разряд, и установите максимальный 
ток разряда и максимальное напряжение разряда, на закладке CCS Источник 
питания (Supply). Также, не забудьте установить отсечку по напряжению для 
батареи питания и максимальный выходной ток для циклов заряда.

PowerLab 8 автоматически определяет подключение к свинцовой батарее или к источнику 
питания. Если он определит источник питания, он переключается на внутренний 
разряд (от 10mA до 10A, максимум 100 Вт).
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Изменение настройки

Вы можете изменять все свойства настроек напрямую в PowerLab 8.
Используйте эту процедуру в любое время, но необходимо, чтобы PowerLab 8 не 
был подключен к программе CCS.

Совет: Вы можете также настроить закладку CCS Пользовательские 
настройки (Presets) скрыть, показать, копировать и изменять настройки.

1. В списке пользовательских настроек (User Preset), используйте INC или 
DEC для выбора настройки, которую вы хотите изменить. Нажмите и 
держите INC или DEC для быстрой прокрутки.

2. Нажмите INC+DEC для доступа к настройкам.

3. На экране Choose TASK? > Preset Settings, нажмите ENTER. Теперь вы 
увидите первые несколько настроек.

4. На каждом экране свойств:

n Нажмите INC или DEC для выбора желаемого значения, затем нажмите 
ENTER для сохранения этого значения и перемещения к следующему 
экрану.

n Нажмите ENTER для перемещения к следующему экрану без изменения 
свойства.

n Нажмите BACK для перемещения к предыдущему экрану.

n В любой момент, нажмите и держите BACK для возврата к списку 
пользовательских настроек. Сделанные изменения будут применены к 
пользовательской настройке.

5. Когда вы снова увидите Choose TASK? > Preset Settings, вы завершили 
полный проход по всем свойствам для этой пользовательской настройки.

6. Нажмите BACK для возврата к списку пользовательских настроек (User
Preset).

Смотрите также
Закладка CCS Пользовательские настройки (Presets)
Управление настройками
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Управление настройками

В PowerLab 8 вы можете:

n Очистить пользовательскую настройку (User Preset).
n Скопировать библиотечную настройку (Library Preset) в пользовательскую.

Совет: Вы можете также настроить закладку CCS Пользовательские 
настройки (Presets) скрыть, показать, копировать и изменять настройки.

Примечание: Если опция Preset Changes Always Save?
установлена в Y, или если опция Save Preset Changes done at
PowerLab включена на закладке CCS Настройки (Options), и если 
CCS запущена и сообщается с PowerLab 8, очистка и копирование 
настроек отображается на закладке CCS Настройки (Options).

Очистка пользовательской настройки
Вы можете удалить пользовательские настройки, которые вам не нужны. Например,
если вы не заряжаете батареи A123 и свинцовые батареи, вы можете удалить эти 
настройки, чтобы ограничить меню пользовательскими настройками, которые вы 
используете.
1. В списке пользовательских настроек, используйте INC или DEC для выбора 

настройки, которую вы хотите очистить. Нажмите и держите INC или DEC для 
быстрой прокрутки.

2. Нажмите INC+DEC для доступа к настройкам.
3. На экране Choose TASK?, нажимайте INC пока не увидите Manage Presets,

затем нажмите ENTER.
4. На экране Clear Current Preset?, нажмите INC для отображения Y, затем 

нажмите ENTER.
5. На экране Confirm CLEAR Preset?, нажмите INC для отображения Y,

затем нажмите ENTER.
6. На экране Preset Cleared, нажмите и держите BACK для возврата к списку 

пользовательских настроек. Вы увидите EMPTY PRESET для очищенной 
настройки.

Совет: CCS обеспечивает лучшее управление настройками (смотрите 
закладку Пользовательские настройки (Presets)). Удаление настройки 
в PowerLab 8, например, оставляет пустое место. CCS позволяет 
скрыть настройку, что позволяет снизить число видимых настроек.

Копирование библиотечной настройки
PowerLab 8 поставляется с 50 библиотечными настройками (Library Preset).
Библиотечная настройка (которую вы не можете изменить) является отправной 
точкой для создания собственных пользовательских настроек (которые вы можете 
изменять). FMA конфигурирует библиотечные настройки с оптимальными 
характеристиками заряда для многих химий батарея и стратегий заряда. Вы можете 
заменить существующую пользовательскую настройку библиотечной настройкой, или 
- если установлено менее 25 пользовательских настроек - вы можете создать новую 
настройку из библиотечной настройки. Потом вы можете загрузить библиотечную 
настройку в пользовательскую, и сможете изменять ее свойства.
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1. В списке пользовательских настроек, используйте INC или DEC для выбора 
позиции куда вы хотите вставить новую настройку. Выбор EMPTY PRESET
обычно будет лучшим, если только вы не хотите намеренно перезаписать 
существующую настройку. Нажмите и держите INC или DEC для быстрой 
прокрутки.

2. Нажмите INC+DEC для доступа к настройкам.

3. На экране Choose TASK?, нажимайте INC пока не увидите Manage Presets,
затем нажмите ENTER.

4. На экране Clear Current Preset? > N, нажмите ENTER.

5. На экране Copy Preset from Library?, нажмите INC для отображения Y,
затем нажмите ENTER.

6. В списке библиотечных настроек, нажмите INC или DEC для выбора 
библиотечной настройки, которую вы хотите скопировать, затем нажмите 
ENTER.

7. На экране Confirm COPY from Library?, нажмите INC для отображения 
Y, затем нажмите ENTER.

8. На экране Library Preset has been Copied, нажмите и держите BACK для 
возврата к списку пользовательских настроек. Вы увидите новую 
пользовательскую настройку.

9. При необходимости, измените свойства пользовательской настройки.
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Использование управляющей программы

Знакомство с CCS
Программа PowerLab 8 Charge Control Software (CCS) обеспечивает вам широкие возможности по 
настройке PowerLab 8.

Эта таблица перечисляет общие задачи CCS. Что вы хотите сделать?

Чтобы сделать это... Пройдите сюда...
Загрузка и установка CCS Подробно

Мониторинг напряжения батареи, напряжения банки 
и других данных во время заряда

Закладка Cells Подробно

Старт и управление зарядом из CCS Закладка Cells Подробно

Просмотр данных заряда в виде графиков Команда View > Graphs Подробно

Изменение интервала обновления графика Команда View > Preferences >
Graphing Update Rate

Подробно

Просмотр внутреннего сопротивления банок при заряде Закладка Int. Res. Подробно

Мониторинг напряжения и тока питания при заряде Закладка Supply Подробно

Указание типа источника питания и параметров 
работы источника питания

Закладка Supply Подробно

Обновление прошивки PowerLab 8 Закладка Firmware Подробно

Обновление библиотечных настроек Закладка Firmware Подробно

Восстановление заводских пользовательских настроек Закладка Firmware Подробно

Настройка, сохранение и загрузка настроек PowerLab 8 Закладка Options Подробно

Изменить параметры пользовательской настройки Закладка Presets Подробно

Показать, скрыть, сохранить и загрузить настройки Закладка Presets Подробно

Корректировка ошибок пользовательской настройки Закладка Errors Подробно

Создание собственной таблицы заряда (Fuel Wizard) Команда Tools > Generate Fuel Подробно

Запуск нескольких экземпляров CCS Подробно
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Установка CCS
Установите программу Charge Control Software (CCS) со страницы установки 
PowerLab 8 Software Install (на веб-сайте REVOLECTRIX) используя один из 
описанных здесь способов.
Как только программа будет установлена, она при каждом запуске будет автоматически 
проверять веб-сайт на наличие обновлений. Обновления прошивки и библиотечных 
настроек включены в обновления программы.

Обновление версии
С октября 2010, прошивка и программа PowerLab 8 V2 доступны на 
странице PowerLab 8 V2 Software Install. Эта версия включает следующие 
основные возможности:

n Доступен режим расширения каналов (Expansion Channel Mode).
n Поддержка максимального тока заряда 40A.
n Поддержка максимального тока разряда 40A (при использовании 

регенеративного разряда).
n Поддержка мощности 1344 Вт.

Установка версии V2 сделает все пользовательские настройки версии V1
устаревшими. Процесс обновления V1PL8 до V2 автоматически обновит 
прошивку до версии V2 и инициирует восстановление заводских настроек.
Обновление до версии V2 не является обязательным. Кроме того, любое 
зарядное устройство версии V2 может быть понижено до версииV1 с помощью 
переустановки прошивки версии V1.
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Закладка Банки (Cells)

Контролируйте данные заряда и разряда на закладке Банки (Cells). На этой закладке 
вы также можете выбрать пользовательскую настройку (preset) и запустить/ 
остановить работу PowerLab 8.
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Операции на закладке Cells
1. Подключите батарею к PowerLab 8.

2. На закладке Cells, откройте список пользовательских настроек (User Preset, 
внизу закладки), затем выберите настройку, которую вы хотите использовать 
для зарядки. Выбор настройки здесь также выбирает ее в PowerLab 8.

3. Для изменения свойств выбранной настройки:

a. Нажмите кнопку Edit. Это откроет закладку Presets и выберет настройку.
b. Измените свойства настройки, как вам необходимо.
c. Нажмите кнопку Update.
d. Вернитесь на закладку Cells.

4. Нажмите кнопку Start. Это откроет диалог Start.

5. Просмотрите настройки и измените их, как вам необходимо.

6. Нажмите на кнопку, для того, что вы хотите сделать:

n CHARGE ONLY (т.е., без разряда).

n DISCHARGE ONLY (т.е., без заряда).

n MONITOR (нет заряда или разряда, просто контроль напряжения банок).

n n CYCLE (выполнить n циклов заряда/разряда, как указано в настройке).

7. В следующем диалоге, проверьте, что химия настройки соответствует химии 
батареи. Эта проверка дает вам шанс предотвратить зарядку, если химия 
настройки не соответствует химии батареи.

n Если отображенная химия соответствует химии батареи, нажмите OK для 
начала заряда. Перейдите к шагу 5.

или

n Если отображенная химия не соответствует химии батареи, ничего не 
делайте - операция прервется по таймауту. Закройте диалог. На закладке 
Cells, нажмите кнопку RESET. Начните снова с шага 2.

8. В следующем диалоге:

n Введите название графика, который будет отображаться во время работы,
затем нажмите OK.

или

n Если вы не хотите график во время работы, нажмите Cancel (вы можете 
отобразить график позднее, если измените ваше мнение).

9. Во время заряда:



n Контролируйте данные заряда/разряда в левой панели закладки Cells.
Прошедшее время отображается в левом нижнем углу (если вы используете 
Режим расширения каналов с несколькими PowerLab 8, используйте список 
в правой панели для отображения данных из выбранного зарядника).

Совет: Проведите мышью над строкой данных для краткого описания.

n Контролируйте продвижение на графике..

n Для остановки работы: Нажмите кнопку STOP.

10. Когда операция завершена, PowerLab 8 несколько раз просигналит “бип бип бип”.

Примечание: Настройки NiMH,NiCdи свинцовых батарей могут переключаться на 
струйный заряд (trickle charge), после завершения основной зарядки.

11. Отсоедините батарею от PowerLab 8.

Полезные советы

n Процент заряда батареи не отображается во время разряда.
n Процент заряда только тогда точен, если вы используете настройку имеющую 

таблицу заряда, которая подходит для вашей батареи. Если вы не можете 
найти настройку с таблицей, которая соответствует вашей батарее, вы можете 
создать такую с помощью Fuel Wizard.

n Cell 1 - это банка подключенная к отрицательному выводу батареи.
n Bypass банки индицирует процент обхода применяемого для балансировки банок:
0% = нормальный заряд, 100% = полный обход банки для заряда других банок.

n Поле mAh IN/OUT показывает значение mAh для предыдущей операции, если 
таковая имеется. Это особенно полезно, когда циклируется батарея, так как вы 
можете видеть предыдущее значение разряда в mAh, когда заряжаете батарею.
Имейте в виду, что батарея принимает в себя больше энергии, чем отдает,
поэтому mAh IN будет обычно больше, чем mAh OUT.

n Как только вы запустили операцию, вы не можете изменять настройку. Если 
вы сделали ошибку при редактировании настройки, остановите операцию,
отредактируйте настройку, обновите PowerLab 8, затем перезапустите операцию.
Вы можете поставить в очередь редактирование настройки, но вы не можете 
обновить PowerLab 8, пока он не остановлен.

n Вы можете изменить ток заряда или разряда во время работы с помощью 
нажатия кнопки ENTER на PowerLab 8. Это временное изменение текущей 
настройки (изменение не сохраняется в настройке).

Смотрите также
Заряд/разряд/циклирование/мониторинг батареи
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Закладка Internal Resistance
Закладка Int. Res. отображает внутреннее сопротивление банок, при заряде 
балансируемых батарей LiPo и A123. Внутреннее сопротивление не рассчитывается 
или отображается во время циклов разряда.

Примечание: Внутреннее сопротивление может быть измерено только 
для батарей разряженных ниже 75% емкости. Измерение внутреннего 
сопротивления занимает 3 минуты. Внутреннее сопротивление может 
быть вычислено только во время заряда, и только когда батарея 
подключена силовыми и балансировочными проводами.

Если вы заряжаете используя несколько PowerLab 8, используйте список на правой 
панели для отображения данных из выбранного зарядника.

Просмотр индивидуального внутреннего сопротивления банок позволяет вам более 
точно оценивать качество и состояние батареи. Если все банки показывают низкое 
внутреннее сопротивление, это хороший индикатор, что батарея может заряжаться 
и разряжаться при высоких токах. Два примера:

n Батарея с током заряда 5C и током разряда 40–50C может иметь внутреннее 
сопротивление банок 2 мОм. Такое низкое сопротивление позволяет использовать 
большие токи при заряде и разряде батареи без выделения избыточного тепла.

n Батарея с током заряда 2C и током разряда 20–30C может иметь внутреннее 
сопротивление банок от 17 до 20 мОм. Более высокое сопротивление 
препятствует быстрому заряду или разряду батареи, и может выделяться больше 
тепла во время этих операций.

Банка плохо соответствующая остальным банкам в батарее, будет показывать 
значительно отличающееся внутреннее сопротивление. Также, высокое внутреннее 
сопротивление банки, в сравнении с другими банками, может индицировать 
ухудшение свойств банки, что может ухудшить общие характеристики батареи.

Имейте в виду, что индивидуальное внутреннее сопротивление банок будет изменяться 
во время заряда. Это нормально и объясняется различными напряжениями и токами, 
которые применяются к батарее во время заряда.
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Закладка Источник питания (Supply)

Используйте закладку Supply для:

n Установки типа источника питания по умолчанию.
n Указания пределов по напряжению и току для источника питания.
n Контроля напряжения, тока и мощности источника питания.

Источник питания - DC Power Supply

n Enabled: Если отмечено, источник питания выбран.
n Supply Low Voltage Limit: Установите значение немного ниже номинального 

выходного напряжения источника питания. Если напряжение падает ниже этого 
уровня, работа PowerLab 8 остановится. Если напряжение падает достаточно 
быстро, PowerLab 8 может перезагрузиться.

n Current Limit: Установите соответственно (или ниже) максимального выходного 
тока источника питания. Если ток заряда установлен выше, чем позволяет входной 
ток, PowerLab 8 будет потреблять не больше, чем установлено здесь, что может 
ограничить ток заряда. Обычно устанавливается ток на 1 или 2 ампера меньше 
максимального тока источника питания.

Состояние - Supply Status

n Supply Voltage: Напряжение и ток источника питания в реальном времени.
n Output: Мощность источника питания в реальном времени.
n Power Status: отображает “Normal (No Limiting)”, если источник питания 

работает в пределах установленных на этой странице. Если пределы превышены, 
будет отображено соответствующее сообщение.

Если вы заряжаете с использованием нескольких PowerLab 8, используйте список на 
правой панели для отображения данных из выбранного зарядника.

Батарея питания - Battery Power Source
n Enabled: Если отмечено, батарея выбрана.
n Battery Type list: Выберите тип батареи, который будет использоваться для 

питания PowerLab 8. Значения в списке шаблонов являются отправными точками.
Измените следующие значения, как необходимо.

n Show Warning at 50% DOD: Если отмечено, PowerLab 8 измеряет напряжение 
батареи при первом подключении. Если емкость батареи ниже 50% (ниже этого 
порога, большинство наливных свинцовых аккумуляторов повреждаются), PowerLab
8 пищит и выдает предупреждение. Нажмите кнопку BACK для отмены операций 
в PowerLab 8, затем скорректируйте ситуацию (вы можете нажать кнопку 
ENTER для продолжения, но это не рекомендуется).

n Battery Low Voltage Out: Установите нижний порог напряжения. Если батарея 
достигнет этого напряжения, зарядка прекратится для предотвращения глубокого 
разряда. Рекомендуется 11.00V для большинства 12 В батарей. Для батарей 24 В,
установите в 1/2 желаемого напряжения отсечки (PowerLab 8 определяет две 
последовательных батареи 12 В и удваивает Battery Low Voltage Out).
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n Battery Max Amps Out: Установите максимальное потребление тока от батареи.
Если ток заряда больше, чем позволяет входной ток, PowerLab 8 будет потреблять 
не более, чем здесь установлено, что может ограничить ток заряда. Если Battery
Max Amps Out установлен слишком высоко, выходное напряжение батареи 
может упасть ниже порога Battery Low Voltage Out и зарядка остановится.

n Enable Regenerative Discharge: Если отмечено, энергия разряда батареи (до 
40A / 1344 Вт) посылается в батарею питания во время цикла разряда. Если 
не отмечено, энергия разряда рассеивается внутри (ограничено 100 Вт).

n Regen. Amps IN to Pb: Установите макимальный регенеративный ток в батарею 
питания. Учтите химию батареи и размер, когда настраиваете это значение.
Например, свинцовый аккумулятор не должен заряжаться током более C/8.

ПРЕДОСТЕРЕЖЕНИЕ: Избыточный и длительный регенеративный ток 
в батарею питания может повредить батарею и снизить срок службы.

n Regen. Charge Voltage IN to Pb: Установите максимальное регенеративное 
напряжение применяемое к батарее питания. Для батареи питания 24 В, PowerLab
8 автоматически удваивает установленное значение. Если регенеративное 
напряжение достигает установленного значения, PowerLab 8 переключается на 
внутренний разряд для предотвращения избыточного заряда батареи питания.

Расширение каналов - Expansion Channel
Если несколько PowerLab 8 работают в Режиме расширения каналов, выберите 
канал, из которого будут отображаться данные источника питания.

Смотрите также
Smart Power Management
Источники питания
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Закладка Прошивка (Firmware)

Закладка Firmware позволяет вам:

n Определить прошивку установленную в PowerLab 8: Она отображается в 
центре закладки (версия прошивки также отображается на экране приветствия 
PowerLab 8 при включении питания).

n Установить последнюю версию прошивки.
n Загружать и устанавливать свежие библиотечные настройки.
n Восстанавливать заводские настройки.

Для обновления прошивки PowerLab 8:

Совет: Вы можете отобразить подобные инструкции на закладке 
Firmware с помощью нажатия на Click to view instructions.

1. Отсоедините все батареи.
2. Отсоедините зарядники расширения.
3. Включите питание PowerLab 8 от источника 12-24 В.
4. Настройте подключенный PowerLab 8 как главный зарядник (смотрите шаг 

3 в Режиме расширения каналов для подробностей).
5. Подключите PowerLab 8 к компьютеру с использованием адаптера FUIM2

или FUIM3.
6. На закладке CCS Firmware, нажмите кнопку Update Firmware.

Примечание: Не прерывайте процесс обновления прошивки.

Совет: Время оставшееся для обновления прошивки отображается 
ниже кнопки Update Firmware.

7. В диалоге “Firmware Programming Complete”, нажмите кнопку OK.

Для обновления библиотечных настроек (Library Presets):

1. Нажмите на кнопку Update Library.

2. В диалоге подтверждения, нажмите кнопку Yes.

3. Вы будете извещены, когда обновление завершится. В диалоге, нажмите 
кнопку OK.

Для восстановления заводских настроек:

1. Нажмите на кнопку Factory Restore.

2. В диалоге подтверждения, нажмите кнопку Yes.

3. Вы будете извещены, когда восстановление завершится. В диалоге,
нажмите кнопку OK.
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Процесс обновления прошивки и настроек
Со временем, будут выпускаться новые версии CCS и новые заводские настройки 
по умолчанию. Эти изменения могут корректировать нарушения безопасности или 
обеспечивать расширенные возможности, что может вызвать появление ошибок в 
старых настройках при использовании новой прошивки или новой версии CCS. Эта 
процедура позволит вам обновить ваши пользовательские настройки, а также 
прошивку:

1. Сохраните ваши пользовательские настройки по одной за раз, используя 
команду File > Save Preset X to File.

2. Обновите прошивку (смотрите инструкции выше).

3. Выполните восстановление заводских настроек (смотрите инструкции выше).

4. Восстановите пользовательские настройки по одной за раз, используя 
команду File > Open File to Preset X.

5. Проверьте закладку Errors для просмотра, будет ли любая старая 
пользовательская настройка вызывать ошибку с новым CCS/прошивка. Дважды 
проверьте ошибки и скорректируйте проблемы.

6. Повторно сохраните ваши пользовательские настройки по одной за раз, 
используя команду File > Save Preset X to File.
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Закладка Настройки (Options)

На закладке Options вы можете:

n Указать как информация отображается на экране PowerLab 8.
n Контролировать, загружены ли пользовательские настройки в CCS.
n Настроить громкость динамика и параметры сигналов.
n Задать опции запуска.
n Сохранить и загрузить наборы опций.

Примечание: После изменения настроек на закладке Options,
нажмите на кнопку Update для загрузки изменений в PowerLab 8.

Настройки отображения

n Cells Scroll Seconds: Время отображения данных банок на экране во время заряда.
n Cell Decimals: Значение напряжения банок в сотых или тысячных вольта.
n Name on Both Lines: Время отображения длинного имени настройки в обоих 

строках, перед тем как вторая строка заменяется спецификациями заряда.
n Preset Name Scrolling: Время прокрутки имени настройки в верхней строке.
n European comma decimal: Если отмечено, запятая отображается в качестве 

разделителя.
n Text boxes: Разместите ваш текст на экране приветствия при включении зарядника.

Совет: Введите ваше имя и/или номер телефона.

Пользовательские настройки

n Save Preset Changes done at PowerLab: Если отмечено, изменение пользовательских 
настроек в PowerLab 8 сохраняются в текущей настройке и загружаются в CCS.
Отключение этой опции не рекомендуется, но обеспечивает способ временного 
изменения параметров настройки на время одной сессии заряда.

Настройки звуков

n Speaker Volume: Настройка громкости динамика PowerLab 8.
n Charge Done Beeps: Настройка количества сигналов, оповещающих об 

окончании заряда.
n Button Clicks ON: Если отмечено, PowerLab 8 пищит при каждом нажатии 

на кнопку передней панели.
n Quiet Charging: Если отмечено, нет сигналов в ключевых точках заряда.

Настройки старта

n Enable Quick Start: Если отмечено, вы можете обойти вопросы по поводу 
пользовательской настройки - просто нажмите и держите ENTER - когда 
готовитесь заряжать батарею в PowerLab 8.
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n Suppress Use Bananas Question: Если отмечено, последовательность зарядки 
не спрашивает о использовании силовых проводов батареи.

Примечание: Если эта опция отмечена, PowerLab 8 полагает, что 
вы заряжаете с использованием силовых проводов.Попытка заряда 
только через шлейф балансировки приведет к ошибке.

n Choose Power Source at Startup: Если отмечено, вы всегда должны 
указывать источник питания сразу после включения питания PowerLab 8.

Совет: Если вы всегда используете один источник питания, укажите 
источник питания на закладке Питание (Source), затем отключите 
опцию Choose Power Source at Startup. Это позволит обойти этот 
шаг при каждом включении питания PowerLab 8.

Сохранение и загрузка настроек
Для сохранения набора опций на компьютере: Нажмите кнопку Save to File... .

Выберите каталог, введите имя, затем нажмите на кнопку Save.

Для загрузки набора опций с компьютера:

1. Нажмите кнопку Load from File... .

2. Найдите и выберите файл опций, затем нажмите кнопку Open.

3. Нажмите кнопку Update для загрузки опций в PowerLab 8.
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Закладка Пользовательские настройки (Presets)

Программа CCS обеспечивает вам почти полный контроль над пользовательскими 
настройками (User Preset), включая какие из них доступны в PowerLab 8, порядок 
их отображения, характеристики заряда, содержание и порядок экранов данных 
отображаемых во время заряда.

Редактирование

1. Если отмечена опция Advanced Properties, отключите ее (смотрите 
“Расширенные свойства” ниже, для дополнительной информации).

2. В левой панели, нажмите на пользовательскую настройку, которую вы хотите 
редактировать. Параметры и экраны настройки отобразятся в правой панели.

3. Затем:
n Для изменения порядка настроек: В левой панели, перетащите номер 

настройки вверх или вниз.
n Для предотвращения отображения настройки в PowerLab 8: Откройте 

список следующий за настройкой и нажмите Hide (скрыть).
n Для изменения характеристик заряда: Нажмите закладку Properties в 

правой панели, затем настройте опции как необходимо.
n Для изменения экранов данных заряда: Нажмите на закладку Screens в 

правой панели, затем...
l Для изменения того, что отображает экран: Нажмите стрелку за 

предпросмотром экрана, затем выберите желаемую информацию в 
выпадающем списке.

l Для отображения или скрытия экрана данных: Выберите Show (показать) 
или Hide (скрыть), как необходимо.

l Для изменения порядка экрана: Перетащите номер экрана вверх или 
вниз.

4. Нажмите кнопку Update.
или

Если вы не хотите применять изменения, нажмите кнопку Cancel.

Примечание: Программа CCS выполняет исчерпывающие проверки 
для уверенности в том, что вы указываете допустимые параметры.Если 
она находит ошибки, она не загружает настройки в PowerLab 8 до тех 
пор, пока ошибки не исправлены. Ошибки отображаются на закладке 
Errors.  Для исправления ошибки,дважды щелкните по ошибке на закладке 
Errors; вы окажетесь на соответствующем свойстве пользовательской 
настройки, которое вы можете изменить на допустимое значение.

Информация о свойствах
Для просмотра короткого описания свойства: Проведите курсор над меткой 
свойства.

Для просмотра детального описания свойства: Нажмите на метку свойства.
Описание откроется во всплывающем окне.
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Сохранение, загрузка, резервирование и восстановление
Для сохранения пользовательской настройки (User Preset):

1. На закладке Presets, нажмите на пользовательскую настройку, которую 
вы хотите сохранить. Выбранная настройка будет иметь серый фон.

2. File > Save Preset X to File... . Это откроет диалог Save a Preset.

3. Пройдите в каталог, где вы хотите сохранить файл.

4. (Опция) Перезапишите имя настройки по умолчанию (это не изменит 
отображаемое имя настройки).

5. Нажмите кнопку Save.

Совет: Сохраните ваши настройки индивидуально,как описано выше,
для большей гибкости при загрузке. Позже, вам может потребоваться 
восстановление заводских настроек для получения последних настроек 
от REVOLECTRIX. Если это произойдет, вы оцените наличие копий.

Для загрузки сохраненной настройки:

1. На закладке Presets, нажмите на положение, куда вы хотите загрузить 
настройку. Выбранное положение будет иметь серый фон.

Примечание: Вы можете загрузить файл настройки в любое положение.
Загруженный файл перезапишет настройку в выбранном положении.Вы не 
можете загрузить файл в положение библиотечной настройки.

2. File > Open File to Preset X... . Это откроет диалог Open a File to Preset X.

3. Пройдите в каталог, где хранится файл настройки.

4. Нажмите на файл настройки.

5. Нажмите кнопку Open.

6. Измените настройку как необходимо.

7. Нажмите кнопку Update для загрузки настройки в PowerLab

8. Для загрузки настройки из сохраненного графика:

1. На закладке Presets, нажмите на положение, куда вы хотите загрузить 
настройку. Выбранное положение будет иметь серый фон.

2. File > Open Graph to Preset X... . Это откроет диалог Open a File to Preset X.

3. Пройдите в каталог, где хранится файл графика.

4. Нажмите на файл графика.

5. Нажмите кнопку Open.

Для сохранения всех пользовательских настроек в одном файле:

1. На любой закладке, File > Backup All User Presets... . Это откроет 
диалог Backup User Presets.
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2. Пройдите в каталог, где вы хотите сохранить файл архива.

3. Введите имя для файла архива.

4. Нажмите кнопку Save.

Для восстановления всех пользовательских настроек из архива:

Примечание: Эта перезапишет все пользовательские настройки.

1. На любой закладке, File > Restore All User Presets... . Это откроет диалог 
Restore User Presets.

2. Пройдите в каталог, где хранится архивный файл.

3. Нажмите на архивный файл.

4. Нажмите кнопку Open.

5. Нажмите кнопку Update для загрузки пользовательских настроек в PowerLab 8.

Совет: Используйте команды Backup и Restore, когда вы хотите 
полностью изменить операции PowerLab 8.Например, у вас есть один 
PowerLab 8 для зарядки только литиевых батарей и другой PowerLab
8 для зарядки только NiCd/NiMH батарей. Пакетное архивирование 
не является заменой архивирования индивидуальных настроек. В 
будущем, если вам потребуется восстановление заводских настроек 
для получения новых настроек, восстановление пакетного архива не 
очень поможет.Многие настройки в архиве могут генерировать ошибки 
при запуске с новой прошивкой и/или версией CCS. Лучше загружать 
настройки индивидуально и корректировать появляющиеся ошибки 
(смотрите закладку Ошибки (Errors)).

Расширенные свойства (Advanced)
Основные свойства определяют параметры заряда и разряда, которые необходимы для 
большинства пользователей. Расширенные свойства включают в себя расширенный 
набор параметров, который может быть полезен для пользователей со 
специальными требованиями.

Для просмотра и настройки расширенных свойств: Активируйте опцию 
Advanced Properties.
Доступ к расширенным свойствам осуществляется через закладки на 
правой панели.

Смотрите также
Изменение настройки
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Закладка Ошибки (Errors)

Закладка Errors перечисляет ошибки пользовательских настроек обнаруженных 
PowerLab 8.
Если ошибок нет, закладка помечена No Errors. Если имеются ошибки 
пользовательских настроек, закладка помечена X Errors, где X это общее количество 
ошибок обнаруженных во всех загруженных настройках.
Для корректировки ошибок: На закладке Errors, дважды щелкните по описанию 

ошибки. CCS отобразит соответствующее положение в свойствах пользовательской 
настройки.

Ошибки в пользовательских настройках
Когда вы изменяете пользовательскую настройку, CCS обычно предоставляет только 
действительные опции для различных параметров. Но все равно возможно установить 
конфликтные значения, однако, CCS проверяет все изменения для уверенности в 
том, что все сделанные изменения не нарушают правил безопасности.

Со временем, будут выпускаться новые версии CCS и новые заводские настройки 
по умолчанию. Эти изменения могут корректировать нарушения безопасности или 
обеспечивать расширенные возможности, что может вызвать появление ошибок в 
старых настройках при использовании новой прошивки или новой версии CCS. Эта 
процедура позволит вам обновить ваши пользовательские настройки, а также 
прошивку:

1. Сохраните ваши пользовательские настройки по одной за раз, используя 
команду File > Save Preset X to File.

2. Обновите прошивку (смотрите инструкции для закладки Прошивка 
(Firmware)).

3. Выполните восстановление заводских настроек (смотрите инструкции для 
закладки Прошивка (Firmware)).

4. Восстановите пользовательские настройки по одной за раз, используя 
команду File > Open File to Preset X.

5. Проверьте закладку Errors для просмотра, будет ли любая старая 
пользовательская настройка вызывать ошибку с новым CCS/прошивка. Дважды 
проверьте ошибки и скорректируйте проблемы.

6. Повторно сохраните ваши пользовательские настройки по одной за раз, 
используя команду File > Save Preset X to File.
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Графики

Графики CCS позволяют вам видеть как характеристики батареи изменяются 
во время операция заряда и разряда.

Когда вы запускаете заряд, CCS открывает диалог, в котором вы можете назвать 
график. Введите описательное имя, затем нажмите OK.

Примечание: В этот момент, график записывается в память вашего 
компьютера. Он пока не сохранен на жесткий диск.

Для настройки интервала обновления графика: В главном окне CCS, View >
Preferences > Graphing Update Rate.

Совет: Если у компьютера много оперативной памяти, выбор небольшого 
интервала обновления является нормальным. Для более старых 
компьютеров, оставьте значение по умолчанию 10 секунд.

Для просмотра графика: В главном окне CCS, View > Graphs. Это откроет окно 
Graph.

Выполните следующие операции в окне Graph.

Для выбора параметров отображаемых на графике: 

n View > Amps vs. Time
n View > Cell Volts vs. Time
n View > Fallback vs. Time 
n View > Fuel vs. Time
n View > Internal Resistance vs. Time
n View > Pack Capacity vs. Time
n View > Pack Volts vs. Time
n View > Cell Volts vs. Capacity

Примечание: Доступность некоторых графиков зависит от химии
заряжаемых батарей.

Для измерения значений и времени на графике: Проведите курсором над 
графиком. Значение и время отобразятся в командной строке.

Для настройки графиков: View > Options.
Для увеличения: Нарисуйте прямоугольник вокруг области, которую вы 

хотите увеличить. После этого, используйте команды в меню Zoom.
Для изменения размера окна графика: Потяните за любой угол или сторону,

или нажмите кнопку максимизации окна.
Для аннотации графика: Введите примечания в левом нижнем углу.
Для сохранения графика как изображения: File > Save As.
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Для печати графика: File > Print.

После генерации графика, выполните следующие операции в главном окне CCS.

Для сохранения данных графика: File > Save Graph (это сохраняет все данные, а 
не только данные отображаемые на графике).

Совет: CCS предупредит вас о необходимости сохранить график, 
если вы остановили зарядку или пытаетесь выйти из программы.

Для сохранения данных графика в месте на ваш выбор: File > Save Graph As... .

Для отображения сохраненных данных как графика: File > Open Graph...
(вы можете просмотреть все параметры, которые были записаны).

Для очистки данных из окна Graph: File > Close Graph.

Экспорт графиков
Вы можете экспортировать данные графика для детального анализа в других 
программах, таких как электронные таблицы. Вам не нужно экспортировать график 
немедленно - как только вы сохранили график, вы можете позже открыть его для 
экспорта данных.

CCS экспортирует данные в одном из двух форматов:

n Текст разделенный табуляторами. Этот формат экспортирует все данные записанные 
CCS, включая данные, которые не отображались на графике. Некоторые их этих 
данных чисто технические и относятся к работе PowerLab 8. Другие данные,
такие как напряжение источника питания, могут обеспечить полезные подсказки.

n Формат BT2 используется программным обеспечение West Mountain Radio
CBA. Этот формат экспортирует только напряжение от заряда. Файл BT2 может 
модифицироваться текстовым редактором. Одним из рекомендуемых изменений 
являет редактирование имени файла в строке 6, которое может не подходить для 
отображения на графике программы CBA.

Для экспорта данных графика в текстовый файл:
File > Export Graph > Text File... .

Для экспорта данных напряжения в формате CBA:
File > Export Graph > West Mountain CBA II File... , выберите данные, которые 

вы хотите экспортировать, затем нажмите кнопку Export.
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Создание таблицы заряда

PowerLab 8 вычисляет уровень заряда батареи на основе таблицы заряда для конкретного 
производителя или химии. Даже две LiPo батареи различного времени выпуска или 
различных марок одного времени выпуска могут иметь различные напряжения от 
времени во время заряда. Когда таблица заряда не соответствует химическому 
составу банок, могут произойти ошибки в определении уровня заряда.

Точная таблица заряда может быть сгенерирована с помощью циклирования банки 
(или батареи) и записи напряжения банки. Помощник таблицы заряда (Fuel Table
Wizard) автоматизирует этот процесс. Однако, это потребует нескольких часов для 
завершения.

1. Tools > Generate Fuel. Это откроет Fuel Wizard.

2. Следуйте инструкциям в Fuel Wizard.

3. Нажмите кнопку Generate Fuel.

О таблицах заряда
Как узнать нужна ли вам собственная таблица заряда для вашей батареи? Если 
вы используете автоматический режим (AUTO 1C, 2C или 3C) для упрощенного 
заряда, и ваша батарея отличается от обычной батареи от 15C до 20C LiPo, вам 
возможно нужна собственная таблица заряда. Ключом является то, что PowerLab 8
превышает или занижает оптимальные уровень тока, при использовании одной 
из точных настроек (Accurate Charge presets).

Предположим, что вы заряжаете батарею 2200mAh, и настроили PowerLab 8 для 
заряда AUTO 2C. Если батарея почти полностью разряжена, когда вы начинаете 
заряд, тогда в течении 10–20 минут ток постепенно должен увеличится примерно до 
4A (идеальный заряд 2C должен быть 4.4A, но PowerLab 8 намерено консервативен 
в автоматическом режиме (AUTO), даже если таблица заряда точно соответствует 
химии батареи).

Если вы видите, что ток заряда достигает только 1A или 2A, или поднимается до 6A
или выше, тогда вам необходимо сгенерировать собственную таблицу заряда, 
чтобы PowerLab 8 корректно вычислял токи для автоматического режима заряда. В 
качестве альтернативы вы можете вручную установить ток 4.4A, когда заряжаете 
такую батарею. Имейте в виду, что PowerLab 8 будет использовать доступную 
таблицу заряда во время автоматического и ручного режимов заряда для оценки 
текущей емкости заряжаемой батареи.

Другим путем узнать, когда батарея нуждается в собственной таблице заряда: Если 
заряжалась до 100%, затем вы летали короткое время и заметили, что осталось 
только 20% заряда.
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Запуск нескольких экземпляров CCS
Вы можете запустить несколько экземпляров CCS на одном компьютере для 
поддержки нескольких PowerLab 8. Как это сделать:

1. Подключите первый PowerLab 8 к компьютеру с помощью адаптера FUIM3.

2. Запустите CCS. В верхней части экрана CCS должно появиться Waiting to Start.

3. Подключите к компьютеру следующий PowerLab 8 используя другой адаптер 
FUIM3.

4. Снова запустите CCS (это будет второй экземпляр). В верхней части 
экрана CCS должно появиться Waiting to Start.

Конфигурация D и Конфигурация G в разделе “Подключение батарей: расширенно”
показывает проводку, которая поддерживает несколько экземпляров CCS.
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Дополнительная информация

Советы по зарядке

Общая информация

n Так как технология балансировки PowerLab контролирует индивидуальные 
банки, нет необходимости охлаждать батарею перед зарядкой. Переходите от 
полета к зарядке и от зарядки к полету без ожидания.

n Банки в батарее имеют различное напряжение, когда они разряжены. PowerLab
8 балансирует (выравнивает) напряжение банок во время заряда батареи.
Зарядники REVOLECTRIX обеспечивают самый большой ток балансировки в 
индустрии: до 1A, и теперь он может настраиваться пользователем.

n Во время заряда, банки, которые заряжаются быстрее, являются самыми слабыми 
банками в батарее. В конце заряда, банки с самым высоким напряжением являются 
самыми слабыми банками в батарее. Это происходит потому, что слабые банки 
имеют меньшую емкость,и они заряжаются быстрее, чем хорошие банки.

n Если PowerLab 8 отображает LOW VOLT RESTORE, батарея была 
глубоко разряжена во время последнего использования. Зарядник попытается 
восстановить банки LiPo с напряжением между 0,5 В и 2,7 В, или банки A123 с 
напряжением между 0 В и 2,0 В. Для избежания повреждения восстановленных 
банок, глубоко не разряжайте восстановленную батарею.

n По определению, конец жизни банок LiPo настает, когда банка может быть 
заряжена только до емкости 80% от ее номинальной емкости. Количество 
циклов заряда/разряда банки перед окончанием ее жизни зависит от нескольких 
факторов, включая качество банок, ток разряда, внутреннее тепло выделяющееся 
во время использования, и других параметров. Банки в старой батарее могут 
быть больше разбалансированы, но PowerLab 8 будет по прежнему балансировать 
их до различия в 6 мВ в конце заряда. По этой причине, балансировка старых 
батарей может занимать больше времени. Зарядник может показывать FUEL=99%
в течении нескольких часов, когда балансирует старую батарею высокой 
емкости, которая серьезно разбалансирована, но пользовательская настройка 
может быть настроена на окончание балансировки после установленного времени.
Часто, последние несколько мВ балансировки занимают длительное время и 
не улучшают значительно общий заряд батареи или ее характеристики.

Зарядка батарей

n Вы можете заряжать батареи до конца, или прекращать заряд, когда они 
заряжены частично. Вы не сможете повредить батарею при использовании 
PowerLab 8 (Единственное исключение, если вы используете адаптеры “Safe
Parallel” и случайно подключили параллельно две батареи с различным 
количеством банок. Это не функция PowerLab 8, а больше ваша ответственность 
по правильному подключению батарей к PowerLab 8.)
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n Если батарея с зарядом 80% или меньше, подключается к регулятору скорости с 
авто-детектированием, регулятор может снизить напряжение отсечки. Это 
приведет к глубокому разряду батареи во время полета. Регуляторы скорости с 
авто-детектированием правильно устанавливают напряжение отсечки, если 
батарея заряжена как минимум до 90%.

n Для экономии времени, останавливайте зарядку, когда батарея достигает примерно 
95% емкости. Эти последние 5% самые долгие. По умолчанию, пользовательские 
настройки (User Preset) извещают вас двумя сигналами, когда батарея достигает 
90% емкости (этот порог может быть изменен в программе CCS).

n Некоторые банки могут проседать на 0,10 В в течение часа после заряда. Это 
нормально для батарей с возрастом.

n По мнению REVOLECTRIX, глубокий разряд батареи A123 ниже 2,0 В/банка 
повреждает банки (в противоположность другим отчетам). PowerLab 8 требует 
минимального напряжения батареи 1,5 В для активации заряда. Если батарея 
A123 находится ниже этого напряжения, не пытайтесь восстановить батарею 
путем поднятия напряжения. Даже если вам удастся восстановить батарею, у нее 
останется мало циклов и PowerLab 8 отвергнет ее по многим причинам 
(как индицируется отображаемыми кодами безопасности).

Хранение батарей

n Для наилучших результатов, батареи LiPo и A123 должны храниться при 50%
заряде. Используйте настройку PowerLab 8 LiPo All Brands Storage Charge для 
подготовки LiPo батарей для хранения, и настройку A123 All Cpcty Storage
Charge для подготовки A123 батарей для хранения.

ПРЕДОСТЕРЕЖЕНИЕ: Убедитесь, что настройка хранения 
соответствует химии батареи.

n LiPo батареи заряженные до 100% не должны охлаждаться ниже комнатной 
температуры. Банки с зарядом 90% или меньше, можно охлаждать ниже 32ºF
(0ºC).
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Как работает режим автоматического тока

Режим автоматического тока PowerLab 8 (Auto Current Mode, индицируемый током 
заряда Ax.0C) точно контролирует индивидуальные уровни заряда банок (напряжение 
банок) для LiPo, Li-Ion или A123 батареи. Если PowerLab 8 определяет, что зарядка 
слишком быстрая, он замедляет заряд. Сходным образом, зарядка слишком медленная,
он ускоряет заряд. PowerLab 8 регулирует ток заряда с 1 минутным интервалом в 
течение цикла заряда.

Когда заряд стартует, в течение некоторого времени PowerLab 8 определяет 
корректные параметры, поэтому это может занять до 30 минут, пока он остановится 
на оптимальном токе. Это нормально, и не повредит батарее. Чем дольше заряд,
тем точнее вычисления.

График ниже показывает как режим автоматического тока регулирует ток заряда, когда 
заряжает батарею 2,1Ah с автоматическим током заряда 1.0C. Сначала, ток заряда 
500mA (этот стартовый ток определен в пользовательской настройке и является 
настраиваемым). В течение нескольких минут, PowerLab 8 увеличивает ток, в конце 
концов он достигает 1.0C (1,9A в этом примере). Это немного меньше идеального 
тока заряда 1.0C или 2,1A для этой батареи. Ток заряда режима автоматического 
тока намеренно сделан слегка консервативным. Ток падает, когда батарея 
достигает полного заряда (зарядник переходит в режим постоянного напряжения).
Когда ток заряда падает примерно до 0,05C, батарея полностью заряжена. Если 
банки сбалансированы, заряд завершается. Настройки окончания заряда также 
контролируются параметрами пользовательской настройки.

В режиме автоматического тока 1.0C, полностью разряженная батарея заряжается 
до номинальной емкости примерно от 60 до 80 минут, в зависимости от состояния 
баланса банок. Режим автоматического тока учитывает начальную степень заряда 
батареи, поэтому заряд батареи с 50% зарядом занимает примерно 30 минут.

Если вы найдете, что режим автоматического тока неправильно вычисляет 
идеальный ток заряда для батареи, эта батарея возможно требует собственной 
таблицы заряда. Смотрите Создание таблицы заряда для подробностей.
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Оценка факторов производительности

Если у вас нет способа прямого измерения электрических параметров силовой 
установки, PowerLab 8 позволяет вам оценить их с использованием предполетных 
и послеполетных измерений.

Примечание: Расчеты приведенные ниже лучше работают, когда батарея 
заряжается с использованием собственной таблицы заряда. Они могут 
быть неправильными, если таблица не соответствует батарее.

1. Сбор данных

a. Зарядите батарею.
b. Когда зарядка завершена, запишите заряд % и общее напряжение батареи 

(т.е. сумму напряжения всех банок).
c. Совершите полет (или тест на стенде). Запишите полетное время в минутах.
d. Подключите батарею к заряднику. Запишите заряд % и общее напряжение 

батареи.
2. Расчет факторов производительности

Таблица “LiPo Performance Estimator” (оценка производительности LiPo),
которая упрощает эти вычисления, может быть загружена со страницы 
www.revolectrix.com/downloads

3. Оценка результатов

n Средний ток во время полета дает вам грубую оценку того, что компоненты 
системы - ESC, мотор, разъемы и проводка - работают в пределах своих 
возможностей по току. Имейте в виду, что пиковый ток во время полета 
может существенно превосходить средний ток, который вы вычислили.
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n Ватты на фунт веса являются примерным индикатором производительности 
авиамодели (другие факторы влияющие на производительность включают 
подъем, сопротивление и тип мотора). Здесь приведены некоторые данные:

l от 25 до 30 ватт на фунт: горизонтальный полет.
l от 40 до 50 ватт на фунт: взлет с ровной поверхности, подъем.
l от 50 до 75 ватт на фунт: взлет с травы, спортивная аэробатика.
l от 75 до 125 ватт на фунт: сложная аэробатика.
l Свыше 125 ватт на фунт: 3D.
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Разводка балансировочного разъема

Для батареи 8s, разъем балансировки разводится следующим образом:

Положительный и отрицательный выводы всегда подключены к батарее. Положительный 
вывод подключается к плюсу (+) последней банки. Отрицательный вывод подключается 
к минусу (-) первой банки. Если в батарее меньше 8 банок, более высокие контакты 
не подключаются. Ниже показана разводка двух батарей.
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Открытая архитектура настроек
PowerLab 8 может быть описан как управляемый пользовательскими настройками. 
Все основные аспекты его работы определяются как параметры на уровне 
пользовательских настроек. Факт, что вы (по большей части) можете настраивать 
эти параметры, вводит концепцию “открытой архитектуры настроек”.
В качестве примера, как параметры пользовательских настроек влияют на процесс 
заряда, каждая настройка автоматического режима включает таблицу заряда, уникальную 
для конкретной химии батареи. Когда вы выбираете пользовательскую настройку для 
марки REVO Red, например, вы также выбираете таблицу заряда связанную с этой 
маркой. PowerLab 8 использует таблицу заряда для регулировки тока и поддержки 
указанного тока заряда. Таблица заряда для данной марки, уровень заряда и режим  
автоматического тока являются очень точными.
Когда готовитесь заряжать батарею, первым шагом является нахождение подходящей 
пользовательской настройки (User Preset). Если такой нет, вы можете создать 
пользовательскую настройку из ближайшей библиотечной настройки. Или вы 
можете выбрать пользовательскую настройку из библиотеки доступной в программе 
CCS (которая позволяет вам загружать, выбирать, сохранять и обмениваться 
пользовательскими настройками). Вы можете даже создать новую, собственную 
таблицу заряда для любой химии литиевых батарей, используя Fuel Table Wizard.
Инженеры FMA постоянно обновляют библиотеку настроек, которая включена в каждое 
обновление программы CCS. Эта библиотека будет поддерживаться в будущем, по 
мере того, как будут появляться новые марки и химии батарей.
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Заводские настройки LiPo

LiPo Generic Accurate Charge
Базовая настройка LiPo, которая может быть использована для любой LiPo батареи.
Таблица заряда оптимизирована для обычных LiPo батарей с током разряда до 20C.
Выбираемые токи заряда включают 1C, 2C, 3C AUTO или вручную от 10 mA до
10.0A. Оптимизация для наиболее точной зарядки с настройками завершения C/20 и 
максимальным таймаутом 30 минут для режима C.V. (постоянное напряжение). Эта 
настройка требует, чтобы каждая банка в батарее заряжалась точно до 100%. Если 
используются батареи с высоким током разряда (25C и выше), отсчет уровня заряда 
может быть неточным и ток автоматического режима может быть выше или ниже, 
чем ожидаемый. Настройка по умолчанию 1C AUTO. Параметр Max Auto Amps по 
умолчанию 6A, что означает, если вы это не измените, ток заряда никогда не превысит 
6A в режиме автоматического тока (AUTO). Другие умолчания: ток разряда 2A,
напряжение разряда 3.3V/cell.

LiPo Generic Faster Charge
Базовая настройка LiPo, которая может быть использована для любой LiPo батареи.
Таблица заряда оптимизирована для обычных LiPo батарей с током разряда до 20C.
Выбираемые токи заряда включают 1C, 2C, 3C AUTO или вручную от 10mA до
10.0A. Оптимизация для более быстрого заряда с настройками завершения C/10 и 
максимальным таймаутом 15 минут для режима C.V. (постоянное напряжение).
Эта настройка не требует, чтобы каждая банка в батарее заряжалась точно до 100%.
Если используются батареи с высоким током разряда (25C и выше), отсчет уровня 
заряда может быть неточным и ток автоматического режима может быть выше или 
ниже, чем ожидаемый. Настройка по умолчанию 2C AUTO. Параметр Max Auto
Amps по умолчанию 6A, что означает, если вы это не измените, ток заряда никогда 
не превысит 6A в режиме автоматического тока (AUTO). Другие умолчания: ток 
разряда 2A, напряжение разряда 3.3V/cell.

LiPo Generic High Power
Настойка High Power LiPo может быть использована для любых LiPo батарей, но 
оптимизирована для батарей средней и высокой емкости. Также хорошо подходит 
для балансирующего заряда нескольких параллельно соединенных батарей.
Таблица заряда оптимизирована для обычных LiPo батарей с током разряда до 20C.
Выбираемые токи заряда включают 1C, 2C, 3C AUTO или вручную от 10 mA до
40A. Оптимизация для более быстрого заряда с настройками завершения C/10 и 
максимальным таймаутом 15 минут для режима C.V. (постоянное напряжение).
Эта настройка не требует, чтобы каждая банка в батарее заряжалась точно до 100%.
Если используются батареи с высоким током разряда (25C и выше), отсчет уровня 
заряда может быть неточным и ток автоматического режима может быть выше или 
ниже, чем ожидаемый. Ток заряда по умолчанию 10A вручную. Если вы не создали 
свою настройку и не сгенерировали свою таблицу заряда, мы рекомендуем 
использовать ручную настройку тока заряда, когда используются настройки High
Power. Параметр Max Auto Amps по умолчанию 10A, что означает, если вы это не 
измените, ток заряда никогда не превысит 10A в режиме автоматического тока
(AUTO). Другие умолчания: ток разряда 4A, напряжение разряда 3.3V/cell.
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LiPo Generic Long Life (4.1V)
Базовая настройка LiPo скопированная из настройки 1 выше, но с уменьшенным до 
4,1 В итоговым напряжением. Все остальные параметры такие же. Используйте эту 
настройку, если вы хотите получить от ваших батарей максимальный срок службы,
но имейте в виду, что ваши полеты станут немного короче. Таблица заряда 
оптимизирована для обычных батарей с током разряда до 20C, но таблица 
скорректирована для корреляции с более низким конечным напряжением.

LiPo Generic Small Balanced
Специальная настройка LiPo разработанная для зарядки небольших батарей с 
использованием балансировочного разъема. Эта настройка рекомендуется для 
батарей емкостью от 10 mAh до 500 mAh. Настройка по умолчанию требует ручной 
установки тока заряда от 10 до 500 mA с шагом 5 mA. Оптимизация для наиболее 
точной зарядки с настройками завершения C/20 и максимальным таймаутом 30 минут 
для режима C.V. Эта настройка требует, чтобы каждая банка в батарее заряжалась 
точно до 100%. Если используются батареи с высоким током разряда (25C и выше),
отсчет уровня заряда может быть неточным. Ток заряда по умолчанию 350mA.
Другие умолчания: ток разряда 500mA, напряжение разряда 3.3V/cell.

LiPo 1s/2s Small Non Balanced
Специальная настройка LiPo разработанная для зарядки небольших батарей для 
паркфлаеров, которые не имеют балансировочного разъема. Будьте осторожны 
при зарядке LiPo батарей без балансировки. PowerLab 8 не может определить 
дисбаланс между банками. Никогда не заряжайте без присмотра с этой настройкой.
Эта настройка рекомендуется для батарей с емкостью от 10 mAh до 2000 mAh.
Настройка по умолчанию требует ручной установки тока заряда от 10mA до 2A с 
шагом 5 mA. Таблица заряда оптимизирована для обычных батарей с током разряда 
20C. Оптимизация для более быстрого заряда с настройками завершения C/10 и 
максимальным таймаутом 15 минут для режима C.V. Эта настройка не требует, чтобы 
каждая банка в батарее заряжалась точно до 100%. Если используются батареи с 
высоким током разряда (25C и выше), отсчет уровня заряда может быть неточным.
Ток заряда по умолчанию 350mA.Другие умолчания: ток разряда 500mA, напряжение 
разряда 3.3V/cell.

LiPo All Brands Storage Charge
Специальная настройка LiPo (любой емкости) разработанная для заряда/разряда с 
целю хранения батарей с напряжением 3,86 В на банку. PowerLab 8 автоматически 
определяет необходимость заряда или разряда батареи. Эта настройка использует 
балансирующий заряд до уровня хранения, но разряд завершает по самой 
разряженной банке в батарее.Для завершении разряда, PowerLab 8 содержит алгоритм 
CC/CV для точного напряжения завершения разряда. Требуется ручная установка 
тока разряда от 10mA до 10A. Напряжение завершения заряда и разряда могут 
независимо настраиваться для более высокой точности завершения. Таблица заряда 
оптимизирована для обычных LiPo батарей с током разряда до 20C. Оптимизация 
для очень быстрого заряда с настройками завершения C/5 и максимальным 
таймаутом 15 минут для режима C.V. Эта настройка не требует, чтобы каждая банка 
в батарее заряжалась точно до 100%. Если используются батареи с высоким током 
разряда (25C и выше), отсчет уровня заряда может быть неточным. Ток заряда по 
умолчанию 2A. Другие умолчания: ток разряда 10A, напряжение заряда 3.86V/
cell, напряжение разряда 3.83V/cell.
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Заводские настройки A123

A123 2300 mAh Accurate Charge
Оптимизировано для балансирующей зарядки батарей A123, 2300 mAh (требует 
балансировочного шлейфа на батарее). Таблица зарядки оптимизирована для этого 
конкретного типа батарей и емкости. Выбираемые токи заряда включают 1C, 2C,
3C, 4C, 5C AUTO или вручную от 10 mA до 10A. Оптимизация для точного заряда 
с настройками завершения C/20 и максимальным таймаутом 30 минут для режима 
C.V. Эта настройка требует, чтобы каждая банка в батарее заряжалась точно до 
100%. Эта настройка также может использоваться для батарей типа LiFePO4, 
которые имеют сходные характеристики заряда. При использовании батарей 
LiFePO4, отсчет уровня заряда может быть неточным и ток автоматического 
режима может быть выше или ниже, чем ожидаемый. Ток заряда по умолчанию 
4.6A вручную. Параметр Max Auto Amps по умолчанию 10A, что означает, если вы 
это не измените, ток заряда никогда не превысит 10A в режиме автоматического 
тока (AUTO). Другие умолчания: ток разряда 2.25A, напряжение разряда 2.8V/cell.

A123 2300 mAh Faster Charge
Оптимизировано для балансирующей зарядки батарей A123, 2300 mAh (требует 
балансировочного шлейфа на батарее). Таблица зарядки оптимизирована для этого 
конкретного типа батарей и емкости. Выбираемые токи заряда включают 1C, 2C,
3C, 4C, 5C AUTO или вручную от 10 mA до 10A. Оптимизация для более быстрого 
заряда с настройками завершения C/20 и максимальным таймаутом 15 минут для 
режима C.V. Эта настройка не требует, чтобы каждая банка в батарее заряжалась 
точно до 100%. Эта настройка также может использоваться для батарей типа 
LiFePO4, которые имеют сходные характеристики заряда. При использовании 
батарей LiFePO4, отсчет уровня заряда может быть неточным и ток автоматического 
режима может быть выше или ниже, чем ожидаемый. Ток заряда по умолчанию 
4.6A вручную. Параметр Max Auto Amps по умолчанию 10A, что означает, если вы 
это не измените, ток заряда никогда не превысит 10A в режиме автоматического 
тока (AUTO). Другие умолчания: ток разряда 2.25A, напряжение разряда 2.8V/cell.

A123 2300 mAh High Power
Настройка High Power A123 оптимизирована для быстрой балансирующей зарядки 
батарей A123, 2300 mAh (требует балансировочного шлейфа на батарее). Также, 
хорошо подходит для балансирующей зарядки нескольких параллельно соединенных 
батарей A123. Настройка требует ручной установки тока заряда от 10mA до 30A.
Таблица зарядки оптимизирована для этого конкретного типа батарей и емкости.
Оптимизация для более быстрого заряда с настройками завершения C/20 и 
максимальным таймаутом 15 минут для режима C.V. Эта настройка не требует, 
чтобы каждая банка в батарее заряжалась точно до 100%. Эта настройка также может 
использоваться для батарей типа LiFePO4, которые имеют сходные характеристики 
заряда. При использовании батарей LiFePO4, отсчет уровня заряда может быть 
неточным и ток автоматического режима может быть выше или ниже, чем 
ожидаемый. Ток заряда по умолчанию 10A вручную. Другие умолчания: ток 
разряда 10A, напряжение разряда 2.8V/cell.
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A123 2300 mAh Non Bal. 1-5s
Оптимизировано для небалансирующего заряда батарей A123, 2300 mAh (не требует 
балансировочного шлейфа на батарее).Таблица зарядки оптимизирована для этого 
конкретного типа батарей и емкости. Выбираемые токи заряда включают 1C AUTO
или вручную от 10 mA до 20A. Оптимизация для более быстрого заряда с настройками 
завершения C/10 и максимальным таймаутом 15 минут для режима C.V. Эта 
настройка не может заряжать каждую банку в батарее точно до 100% так как она не 
имеет доступа к индивидуальным напряжениям банок. Дисбаланс будет отображен 
в конце зарядки, однако, банки A123 не так чувствительны к этой проблеме. Тем не 
менее, когда это возможно, рекомендуется заряжать батареи A123 с использованием 
балансирующего заряда. Эта настройка также может использоваться для батарей 
типа LiFePO4, которые имеют сходные характеристики заряда. При использовании 
батарей LiFePO4, отсчет уровня заряда может быть неточным и ток автоматического 
режима может быть выше или ниже, чем ожидаемый. Параметр Max Auto Amps по 
умолчанию 5A, что означает, если вы это не измените, ток заряда никогда не 
превысит 5A в режиме автоматического тока (AUTO). Ток заряда по умолчанию 
4.6A вручную. Так как эта настройка не ограничена разъемом балансировки, она 
может работать только с батареями 1-5 банок. Другие умолчания: ток разряда
2.25A, напряжение разряда 2.8V/cell.

A123 2300 mAh Non Bal 8s Fixed
Оптимизировано для небалансирующего заряда батарей A123, 2300 mAh (не требует 
балансировочного шлейфа на батарее). Таблица зарядки оптимизирована для этого 
конкретного типа батарей и емкости. Выбираемые токи заряда включают 1C AUTO
или вручную от 10 mA до 20A вручную. Оптимизация для более быстрого заряда с 
настройками завершения C/10 и максимальным таймаутом 15 минут для режима C.V.Эта 
настройка не может заряжать каждую банку в батарее точно до 100% так как она не 
имеет доступа к индивидуальным напряжениям банок. Дисбаланс будет отображен 
в конце зарядки, однако, банки A123 не так чувствительны к этой проблеме. Тем не 
менее, когда это возможно, рекомендуется заряжать батареи A123 с использованием 
балансирующего заряда. Эта настройка также может использоваться для батарей 
типа LiFePO4, которые имеют сходные характеристики заряда. При использовании 
батарей LiFePO4, отсчет уровня заряда может быть неточным и ток автоматического 
режима может быть выше или ниже, чем ожидаемый. Параметр Max Auto Amps по 
умолчанию 5A, что означает, если вы это не измените, ток заряда никогда не 
превысит 5A в режиме автоматического тока (AUTO). Ток заряда по умолчанию 
4.6A вручную. Эта настройка является примером фиксированной настройки. Она не 
детектирует автоматически количество банок в батарее. Она разработана специально 
для батареи A123 с 8 банками. Если ваша батарея A123 имеет другое количество 
банок, скопируйте эту настройку в позицию EMPTY, переименуйте ее, и измените 
параметр “Cells” на закладке “Detection” CCS. Другие умолчания: ток разряда 2.25A,
напряжение разряда 2.8V/cell.

A123 1100 mAh Accurate Charge
Оптимизировано для балансирующего заряда батарей A123, 1100 mAh (требует 
балансировочного шлейфа на батарее). Таблица зарядки оптимизирована для этого 
конкретного типа батарей и емкости. Выбираемые токи заряда включают 1C, 2C,
3C, 4C, 5C AUTO или вручную от 10 mA до 6A. Оптимизация для точного заряда с 
настройками завершения C/20 и максимальным таймаутом 30 минут для режима C.V.
Эта настройка требует, чтобы каждая банка в батарее заряжалась точно до 100%. Эта 
настройка также может использоваться для батарей типа LiFePO4, которые имеют 
сходные характеристики заряда. При использовании батарей LiFePO4, отсчет уровня 
заряда может быть неточным и ток автоматического режима может быть выше или 
ниже, чем ожидаемый. Ток заряда по умолчанию 2.2A вручную. Параметр Max Auto
Amps по умолчанию 6A, что означает, если вы это не измените, ток заряда никогда 
не превысит 6A в режиме автоматического тока (AUTO). Другие умолчания: ток 
разряда 1A, напряжение разряда 2.8V/cell.
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A123 1100 mAh Faster Charge
Оптимизировано для балансирующего заряда батарей A123, 1100 mAh (требует 
балансировочного шлейфа на батарее). Таблица зарядки оптимизирована для этого 
конкретного типа батарей и емкости. Выбираемые токи заряда включают 1C, 2C,
3C, 4C, 5C AUTO или вручную от 10 mA до 6A. Оптимизация для точного заряда с 
настройками завершения C/20 и максимальным таймаутом 15 минут для режима 
C.V. Эта настройка не требует, чтобы каждая банка в батарее заряжалась точно до 
100%. Эта настройка также может использоваться для батарей типа LiFePO4, 
которые имеют сходные характеристики заряда. При использовании батарей LiFePO4,
отсчет уровня заряда может быть неточным и ток автоматического режима может 
быть выше или ниже, чем ожидаемый. Ток заряда по умолчанию 3.3A вручную.
Параметр Max Auto Amps по умолчанию 6A, что означает, если вы это не измените, 
ток заряда никогда не превысит 6A в режиме автоматического тока (AUTO). Другие 
умолчания: ток разряда 1A, напряжение разряда 2.8V/cell.

A123 1100 mAh Non Bal. 1-5s
Оптимизировано для небалансирующего заряда батарей A123, 1100 mAh (не требует 
балансировочного шлейфа на батарее). Таблица зарядки оптимизирована для этого 
конкретного типа батарей и емкости. Выбираемые токи заряда включают 1C AUTO
или вручную от 10 mA до 10A. Оптимизация для более быстрого заряда с 
настройками завершения C/10 и максимальным таймаутом 15 для режима C.V. Эта 
настройка не может заряжать каждую банку в батарее точно до 100% так как она не 
имеет доступа к индивидуальным напряжениям банок. Дисбаланс будет отображен 
в конце зарядки, однако, банки A123 не так чувствительны к этой проблеме. Тем не 
менее, когда это возможно, рекомендуется заряжать батареи A123 с использованием 
балансирующего заряда. Эта настройка также может использоваться для батарей 
типа LiFePO4, которые имеют сходные характеристики заряда. При использовании 
батарей LiFePO4, отсчет уровня заряда может быть неточным и ток автоматического 
режима может быть выше или ниже, чем ожидаемый. Параметр Max Auto Amps по 
умолчанию 3A, что означает, если вы это не измените, ток заряда никогда не 
превысит 3A в режиме автоматического тока (AUTO). Ток заряда по умолчанию 
2.2A вручную. Так как эта настройка не ограничена разъемом балансировки, она 
может работать только с батареями 1-5 банок. Другие умолчания: ток разряда
1A, напряжение разряда 2.8V/cell.

A123 1100 mAh Non Bal 8s Fixed
Оптимизировано для небалансирующего заряда батарей A123, 1100 mAh (не 
требует балансировочного шлейфа на батарее). Таблица зарядки оптимизирована 
для этого конкретного типа батарей и емкости. Выбираемые токи заряда включают 
1C AUTO или вручную от 10 mA до 10A. Оптимизация для более быстрого заряда с 
настройками завершения C/10 и максимальным таймаутом 15 для режима C.V. Эта 
настройка не может заряжать каждую банку в батарее точно до 100% так как она не 
имеет доступа к индивидуальным напряжениям банок. Дисбаланс будет отображен 
в конце зарядки, однако, банки A123 не так чувствительны к этой проблеме. Тем не 
менее, когда это возможно, рекомендуется заряжать батареи A123 с использованием 
балансирующего заряда. Эта настройка также может использоваться для батарей 
типа LiFePO4, которые имеют сходные характеристики заряда. При использовании 
батарей LiFePO4, отсчет уровня заряда может быть неточным и ток автоматического 
режима может быть выше или ниже, чем ожидаемый. Параметр Max Auto Amps по 
умолчанию 3A, что означает, если вы это не измените, ток заряда никогда не 
превысит 3A в режиме автоматического тока (AUTO). Ток заряда по умолчанию 
2.2A вручную. Эта настройка является примером фиксированной настройки. Она не 
детектирует автоматически количество банок в батарее.Она разработана специально для 
батареи A123 с 8 банками. Если ваша батарея A123 имеет другое количество банок,
скопируйте эту настройку в позицию EMPTY, переименуйте ее, и измените 
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параметр “Cells” на закладке “Detection” CCS. Другие умолчания: ток разряда 1A,
напряжение разряда 2.8V/cell.

A123 All Cpcty Storage Charge
Специальная настройка A123 (любой емкости) разработанная для заряда/разряда с 
целю хранения батарей с напряжением 3,335 В на банку. PowerLab 8 автоматически 
определяет необходимость заряда или разряда батареи. Эта настройка использует 
балансирующий заряд до уровня хранения, но разряд завершает по самой разряженной 
банке в батарее. Для завершении разряда, PowerLab 8 содержит алгоритм CC/CV
для точного напряжения завершения разряда. Требуется ручная установка тока 
разряда от 10 mA до 10A. Напряжение завершения заряда и разряда могут 
независимо настраиваться для более высокой точности завершения. Таблица заряда 
оптимизирована для батарей A123 2300 mAh. Оптимизация для более быстрого заряда 
с настройками завершения C/20 и максимальным таймаутом 15 минут для режима 
C.V. Эта настройка не требует, чтобы каждая банка в батарее заряжалась точно до 
100%. При использовании батарей A123 1100 mAh или LiFe-PO4, отсчет уровня 
заряда может быть неточным. Ток заряда по умолчанию 2.2A. Другие умолчания:
ток разряда 10A, напряжение заряда 3.335V/cell, напряжение разряда 3.32V/cell.

A123 Store Non Bal. 1-5s
Специальная настройка A123 (любой емкости) разработанная для небалансируемого 
заряда/разряда с целю хранения батарей с напряжением 3,335 В на банку. PowerLab 
8 автоматически определяет необходимость заряда или разряда батареи. Эта 
настройка заряжает до уровня хранения и завершает разряд по самой разряженной 
банке в батарее. Для завершении разряда, PowerLab 8 содержит алгоритм CC/CV
для точного напряжения завершения разряда. Требуется ручная установка тока 
разряда от 10 mA до 10A. Напряжение завершения заряда и разряда могут 
независимо настраиваться для более высокой точности завершения. Таблица заряда 
оптимизирована для батарей A123 2300 mAh. Оптимизация для более быстрого заряда 
с настройками завершения C/10 и максимальным таймаутом 15 минут для режима 
C.V. Эта настройка не может заряжать каждую банку в батарее точно до 100% так 
как она не имеет доступа к индивидуальным напряжениям банок. Дисбаланс будет 
отображен в конце зарядки, однако, банки A123 не так чувствительны к этой 
проблеме. Тем не менее, когда это возможно, рекомендуется заряжать батареи 
A123 с использованием балансирующего заряда. При использовании батарей A123
1100 mAh или LiFe-PO4, отсчет уровня заряда может быть неточным. Ток заряда по 
умолчанию 2.2A. Другие умолчания: ток разряда 10A, напряжение заряда 3.335V/
cell, напряжение разряда 3.32V/cell.

A123 Store Non Bal 8s Fixed
Специальная настройка A123 (любой емкости) разработанная для небалансируемого 
заряда/разряда с целю хранения батарей с напряжением 3,335 В на банку.
PowerLab 8 автоматически определяет необходимость заряда или разряда батареи.
Эта настройка заряжает до уровня хранения и завершает разряд по самой 
разряженной банке в батарее. Для завершении разряда, PowerLab 8 содержит 
алгоритм CC/CV для точного напряжения завершения разряда. Требуется ручная 
установка тока разряда от 10 mA до 10A. Напряжение завершения заряда и разряда 
могут независимо настраиваться для более высокой точности завершения. Таблица 
заряда оптимизирована для батарей A123 2300mAh. Оптимизация для более быстрого 
заряда с настройками завершения C/10 и максимальным таймаутом 15 минут для 
режима C.V. Эта настройка не может заряжать каждую банку в батарее точно до
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100% так как она не имеет доступа к индивидуальным напряжениям банок. Дисбаланс 
будет отображен в конце зарядки, однако, банки A123 не так чувствительны к этой 
проблеме. Тем не менее, когда это возможно, рекомендуется заряжать батареи
A123 с использованием балансирующего заряда. При использовании батарей A123
1100 mAh или LiFe-PO4, отсчет уровня заряда может быть неточным. Ток заряда 
по умолчанию 2.2A. Эта настройка является примером фиксированной настройки.
Она не детектирует автоматически количество банок в батарее. Она разработана 
специально для батареи A123 с 8 банками. Если ваша батарея A123 имеет другое 
количество банок, скопируйте эту настройку в позицию EMPTY, переименуйте ее,
и измените параметр “Cells” на закладке “Detection” CCS. Другие умолчания: ток 
разряда 10A, напряжение заряда 3.335V/cell, напряжение разряда 3.32V/cell.
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Заводские настройки NiMH, NiCd и Lead Acid

NiCd Fast Charge with Trickle
Базовый быстрый заряд NiCd с отсечкой по дельта-пику и струйной подзарядкой.
Требуется ручная установка тока разряда от 10 mA до 20A, со значением по 
умолчанию 1A. Может заряжать батареи с числом банок от 1 до 21. По умолчанию 
падение напряжения 8mV. Ток струйной подзарядки составляет 1/20C от тока заряда.
Таймаут заряда происходит через 4 часа, если дельта-пик не достигнут. Таймаут 
струйной подзарядки установлен в 1 день. Эта настройка только для постоянного 
тока заряда. Не используйте это для Li, Pb или других химий. Другие умолчания:
ток разряда 1A, напряжение разряда 1V/cell.

NiMH Fast Charge with Trickle
Базовый быстрый заряд NiMH с отсечкой по дельта-пику и струйной подзарядкой.
Требуется ручная установка тока разряда от 10 mA до 20A, со значением по 
умолчанию 1A. Может заряжать батареи с числом банок от 1 до 21. По умолчанию 
падение напряжения 5mV. Ток струйной подзарядки составляет 1/20C от тока заряда.
Таймаут заряда происходит через 4 часа, если дельта-пик не достигнут. Таймаут 
струйной подзарядки установлен в 1 день. Эта настройка только для постоянного 
тока заряда. Не используйте это для Li, Pb или других химий. Другие умолчания:
ток разряда 1A, напряжение разряда 1V/cell.

NiCd/NiMH 24 Hr Trickle Charge
Базовая настройка 24 часовой струйной подзарядки NiCd или NiMH. Требуется ручная 
установка тока разряда от 10 mA до 500 mA, со значением по умолчанию 100 mA.
Может заряжать батареи с числом банок от 1 до 21. Таймаут струйной подзарядки 
установлен в 1 день.

Lead 12V SLA or Gel Cell
Базовая настройка заряда свинцовых батарей 12 В SLA или Gel. Требуется ручная 
установка тока разряда от 10 mA до 40A, со значением по умолчанию 7A. Заряжает 
только батареи 12 В. Если требуется заряд 24 В, эта настройка имеется в библиотеке 
и может быть скопирована в пользовательские настройки (смотрите инструкции в 
этом руководстве). Таймаут заряда происходит через 16 часов, если напряжение 
2,33V/cell (по умолчанию) не достигнуто.
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Решение проблем

Ошибки в работе появляются как коды безопасности на экране. Если возможно,
скорректируйте проблему. Если ошибка продолжается, свяжитесь со службой 
поддержки FMA.
Код Причина

1 Increase Supply

2 Supply <10 Volts

3 Supply >16 Volts

4 Supply Unstable

5 Prset not for 4S

6 Bad Preset Versn

7 Reduce NiCd Amps

8 Series Chrgrs?

9 P. Library Empty

10 Low Voltage Cell

11 Preset is Hidden

12 Reverse Polarity

13 Preset is Empty

14 MODE not Pressed

15 System Softstart

16 Preset is Locked

17 Ch1 No Add Up

18 Max Cells Error

19 No Pack

20 Bad Cell Count

21 Bad P. Ram Check

22 Cells Exceeded

23 Un-Bal. Only

24 Charge Timeout

25 Cell Cnt Changed

26 NiCd Detected

27 Cells no Correct

28 Cell OverVoltage

78 High Voltage When Off

79 CH1 Cells Out of Range

88 Checkpack1 Cell V Out of Range
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Code Cause

90 Unknown Screen Number

92 Mux Number Error

93 Calibration Checksum Bad

94 Bad EEPROMWrite

95 Bypass Overvolt

96 PWM Ratio Too High

97 Bad FET Supply Voltage

98 Charger Overcurrent

99 Bad Mode Number

100 Temp out of Rnge

105 Preset not validated

106 Preset number out of range

107 Charge Timeout out of range

108 Preset loaded while charging

109 Charge Termination Unknown

111 Preset Cell OverVolts too High

112 Options Checksum is BAD

113 Charge PWM not regulating

114 Bad Preset Flash Checksum while running

115 Bad Preset Flash Checksum on Start

116 Bad Preset Ram Checksum on Start

117 Bad Segment Checksum on Start

118 Bad Segment Checksum while running

120 Lithium Cell Count not Verified

121 Shunt FET off while CHG/DSCH

122 Unknown Chemistry

123 No Charge Screens to Show

124 Bad Run Screen Number

125 Cell Count is Zero

126 Discharge Mode not set to Balancer

127 Discharge Mode Timeout

128 Peek Detect set past 15 min

129 NiCd Chem must use FallBack

130 Lith Chem must not use FallBack

131 Oscillator Calibration Erased
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Ограниченная гарантия REVOLECTRIX

REVOLECTRIX гарантирует, что PowerLab 8 свободен от дефектов производства 
на срок 1 год с момента приобретения. Если имеется дефект, который покрывается 
этой гарантией, продукт должен быть отремонтирован или заменен на единицу с 
равными характеристиками компанией REVOLECTRIX или авторизованным 
сервисом REVOLECTRIX .

Ограничения и исключения
Эта гарантия может быть реализована только первоначальным покупателем, который 
использует этот продукт в его первоначальном состоянии при покупке, в строгом 
соответствии с инструкциями продукта. Единицы возвращенные для гарантийного 
обслуживания в сервисный центр REVOLECTRIX будут приняты для обслуживания, 
если отправлены с оплаченными почтовыми расходами, с копией оригинального 
чека продажи или с гарантийной регистрационной формой, в сервисную станцию 
определяемую REVOLECTRIX.

Эта гарантия не применима к:

n Косвенные или случайные повреждения вызванные использования этого 
продукта.

n Повреждение вызванное несчастным случаем, неправильным использованием,
плохим обращением, небрежностью, электрическими помехами, обратной 
полярностью в разъемах, грозовыми разрядами или другими непредвиденными 
обстоятельствами.

n Повреждение вызванное отказом следовать инструкциям, поставляемых 
вместе с продуктом.

n Повреждение произошедшее во время доставки продукта клиенту или от 
клиента в сервис (претензии должны предъявляться транспортной компании).

n Повреждение вызванное ремонтом, регулировкой, или любым изменением 
продукта любым лицом, кроме авторизованных специалистов REVOLECTRIX.

n Расходам установки или удаления, или повреждения вызванного неправильной 
установкой или удалением.

Звоните (301) 668-4280 для дополнительной информации об обслуживании и 
гарантийном ремонте.
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Поддержка

Для клиентов в Северной и Южной Америке, которые приобрели продукт 
непосредственно на сайте REVOLECTRIX или FMA Direct, поддержка 
предоставляется FMA Direct:

E-mail продаж: sales@revolectrix.com
E-mail технической поддержки: support@revolectrix.com
Телефон технической поддержки: 301-668-4280
Факс: 301-668-7619

Для клиентов в Северной и Южной Америке, которые приобрели продукт от 
других дистрибьюторов, для поддержки свяжитесь с дистрибьютором.

Для клиентов за пределами Северной и Южной Америки, свяжитесь с 
производителем, Leo Industries в Сингапуре.
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